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Foreword

Welcome to The Beginner’s Guide to DaVinci Resolve 18.

DaVinci Resolve 18 is the only post-production solution that combines editing, color
correction, visual effects, motion graphics, and audio post-production all in one software
tool! Its elegant, modern interface is fast to learn for new users yet powerful enough

for the most experienced professionals. DaVinci Resolve lets you work more efficiently
because you don't have to learn multiple apps or switch software for different tasks. It's
like having your own post-production studio in a single app!

DaVinci Resolve 18 adds Blackmagic Cloud support for remote collaboration, DaVinci
proxy workflow, new Resolve FX, intuitive object masking, improved subtitling for editors,
Fairlight fixed bus to FlexBus conversion, and so much more!

Best of all, Blackmagic Design offers a version of DaVinci Resolve 18 that is completely
freel We've made sure that this version of DaVinci Resolve includes more features than any
paid editing system. That's because at Blackmagic Design we believe everybody should
have the tools to create professional, Hollywood-caliber content without having to spend
thousands of dollars.

I invite you to download your copy of DaVinci Resolve 18 today and look forward to seeing
the amazing work you produce!

Grant Petty
Blackmagic Design

Foreword
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Who This Book Is For

This hands-on training guide is designed for DaVinci Resolve editors, colorists, visual
effects newcomers, and experienced compositors or motion designers who want to
create visual effects and motion graphics in DaVinci Resolve 18. The book is divided into
three parts:

— Part I: Visual Effects Creation
— Part II: Titling and Motion Graphics
— Part III: 3D Compositing

You'll start with an introductory composite that will give you a quick overview of the

Fusion page interface and how nodes work. Each subsequent lesson builds your skills in
the fundamentals of visual effects and motion graphics. You'll cover a variety of genres,
techniques, and technical best practices including title design, hidden effects, green-
screen compositing, visual effects color management, and much more. Finally, you'll work
in Fusion'’s powerful 3D environment creating broadcast design graphics, 3D particles, and
a 3D-tracked composite. Although the last lesson of this guide requires DaVinci Resolve

18 Studio, you can progress through Lessons 1 through 11 using the free download of
DaVinci Resolve 18 from blackmagicdesign.com.

Who This Book Is For
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Getting Started

Welcome to The Visual Effects Guide to DaVinci Resolve 18, an official

Blackmagic Design certified training book that teaches professionals and students
the art of titling, motion graphics, visual effects compositing, and broadcast design
in DaVinci Resolve 18. Editors will find clear workflow-driven lessons, while seasoned
compositors will quickly learn Fusion’s powerful node-based interface to accomplish
incredible Hollywood-caliber visual effects.

As you step through the lessons, you'll gain experience with Fusion’s title animation tools,
particle effects, blue- and green-screen keyer, powerful planar tracking capabilities, 3D
compositing environment, and more! Best of all, you'll discover that there is no longer a
need to send shots out to another application, because with DaVinci Resolve 18, fantastic
visual effects and 3D motion design is simply a click away from editing.

This guide takes a practical, hands-on approach using real-world techniques for various
compositing and broadcast design jobs, including credit rolls, split screens, sky and sign
replacement, 3D graphics, and 3D set extension workflow. Beyond the artistic side of
visual effects and motion graphics, you'll also learn the fundamental science behind the
techniques you're using, including compositing in linear light, managing premultiplied
alpha channels, and maintaining resolution independence. Along the way, you'll find
practical tricks and tips used by professional visual effects artists and motion designers
to enhance the final outcome of your projects. As you complete each lesson, you'll have
opportunities to perform optional practice exercises and answer sample test questions to
test your comprehension of the techniques.

After completing this book, you are encouraged to take the 50-question online proficiency
exam to receive a Certificate of Completion from Blackmagic Design. You can take the
exam online at www.blackmagicdesign.com/products/davinciresolve/training.

DaVinci Resolve is the world's fastest growing and most advanced editing software.

It also has a long history of being the world’s most trusted application for color correction.
With DaVinci Resolve 18, Blackmagic Design has added a complete 2D and 3D visual effects
compositing and motion graphics environment that enables you to complete even the
most challenging projects using only one piece of software!

Getting Started
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In these lessons, you'll work with multiple projects and timelines to learn fundamental and
practical techniques used in a wide range of visual effects and motion graphics genres.
You'll acquire real-world skills that you can apply to real-world productions.

Getting Started

You'll begin with a quick start guide that lets you explore the user interface by creating

a simple but highly realistic sci-fi composite. This lesson is meant to get you comfortable
with the interface and workflow since it touches on all the essential tools that you will use
throughout this guide.

Part |

Part I uses four lessons to cover the most common 2D visual effects techniques that you
can use on a broad range of jobs. You'll uncover various techniques using Fusion’s point
and planar tracking tools so you can realistically integrate objects into a shot. Using the
flexible vector-based Paint tool, you'll remove objects to create hidden effects that viewers
never even know are there. Finally, you'll learn how to approach classic green/blue-screen
compositing that epitomizes visual effects for most people.

Part Il

Part Il includes three lessons covering titling and 2D motion design. You'll learn to

create smooth and highly customizable credit rolls, explore more creative title animation
using Fusion’s unique Follower modifier, and create motion paths that can be published
and shared between any number of elements. Each lesson touches on some aspect of
animation, including Fusion’s powerful keyframe Spline Editor, procedural modifier-based
animations, and simple expressions that can create incredibly natural movement.

Part Il

The final part of this guide uses four lessons to explore 3D compositing and motion
graphics. You'll start by exploring how to set up, navigate, and move around in a 3D
compositing environment. Then, you'll introduce various 3D objects as you design

a broadcast graphic, complete with extruded 3D text, shiny custom brushed-metal
materials, animated camera, and multiple light sources. Some of Fusion’s most useful

and fun tools, the particle tools, are delved into in Lesson 11, as you create billowing
realistic smoke for a 3D composite in a music video. The last lesson in this guide requires
DaVinci Resolve 18 Studio, as it guides you through setting up, optimizing, and making use
of the integrated 3D camera tracking tool for simple set extensions.

Getting Started



Blackmagic Design publishes several training books that take your skills farther in
DaVinci Resolve 18. They include:

— The Beginner’s Guide to DaVinci Resolve 18

— The Colorist Guide to DaVinci Resolve 18

— The Editor’s Guide to DaVinci Resolve 18

— The Fairlight Audio Guide to DaVinci Resolve 18
— The Visual Effects Guide to DaVinci Resolve 18

Whether you want an introductory guide to DaVinci Resolve or you want to learn more
advanced editing techniques, color grading, sound mixing, or visual effects, our certified
training program includes a learning path for you.

After completing this book, you are encouraged to take the 1-hour, 50-question online
proficiency exam to receive a Certificate of Completion from Blackmagic Design. The link to
this exam is located at the end of this book.

The webpage also provides additional information on our official Training and Certification
Program. Please visit www.blackmagicdesign.com/products/davinciresolve/training.

The Colorist Guide to The Editor's Guide to The Fairlight Audi ide to

DaVinci
Resolve 18

Getting Started xiii
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This book supports DaVinci Resolve 18 for Mac and Windows. If you have an older
version of DaVinci Resolve, you must upgrade to the current version to follow along with
the lessons.

NOTE The exercises in this book refer to file and resource locations that will
differ if you are using the version of software from the Apple Mac App Store.
For the purposes of this training book, if you are using macOS we recommend
downloading the DaVinci Resolve software from the Blackmagic Design website
rather than from the Mac App store.

To download the free version of DaVinci Resolve 18 or later from the
Blackmagic Design website:

Open a web browser on your Windows or Mac computer.

In the address field of your web browser, type: www.blackmagicdesign.com/products/

davinciresolve.
On the DaVinci Resolve landing page, click the Download button.

On the download page, click the Mac or Windows button, depending on your
computer’s operating system.

Follow the installation instructions to complete the installation.

When you have completed the software installation, follow the instructions in the following
section to download the content for this book.

The DaVinci Resolve lesson files must be downloaded to your Mac or Windows computer
to perform the exercises in this book. After you save the files to your hard disk, extract the
file and copy the folder to your Movies folder (Mac) or Videos folder (Windows).

Getting Started
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To Download and Install the DaVinci Resolve Lessons Files:

When you're ready to download the lesson files, follow these steps:

Open a web browser on your Windows or Mac computer.

In the address field of your web browser, type: www.blackmagicdesign.com/products/

davinciresolve/training.

Scroll the page until you locate the The Visual Effects Guide to DaVinci Resolve 18.

Click the Part 1 link to download the media. The DR18_Fusion_Training_Media.zip file is
roughly 4 GB in size.

After downloading the zip file to your Mac or Windows computer, open your
Downloads folder and double-click DR18_Fusion_Training_Media.zip to unzip it if
it doesn’t unzip automatically. You'll end up with a folder named R18 Fusion Guide
Lessons that contains all the content for this book.

From your Downloads folder, drag the R18 Fusion Guide Lessons folder to your Movies
folder (Mac) or Videos folder (Windows). These folders can be found within your User
folder on either platform.

You are now ready to begin Lesson 1.

Getting Started XV
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Introducing Blackmagic Cloud

DaVinci Resolve is the world’s only complete post-production solution that lets everyone
work together on the same project at the same time. Traditionally, post-production
follows a linear workflow with each artist handing off to the next, introducing errors and
mountains of change logs to keep track of through each stage. With DaVinci Resolve's
collaboration features, each artist can work on the same project, in their own dedicated
page with the tools they need.

Now Blackmagic Cloud lets editors, colorists, VFX artists, animators, and sound engineers
work together simultaneously from anywhere in the world. Plus, they can review each
other’s changes without spending countless hours reconforming the timeline.

Simply create a Blackmagic Cloud ID, log in to the online DaVinci Resolve Project Server,
and follow the simple instructions to set up a new project library—all for one low
monthly price!

Once created, you can access this library directly from the Cloud tab in the Project
Manager to create as many projects as you need—all stored securely online. Then invite up
to 10 other people to collaborate on a project with you. With a simple click, they can relink
to local copies of the media files and start working on the project immediately, with all their
changes automatically saved to the cloud.

Enabling Multiple User Collaboration for your project means that everyone can work on
the same project at the same time—edit assistants, editors, colorists, dialogue editors,

and visual effects artists can now all collaborate wherever they are in the world in a way
never before possible.

Now you don't need to buy expensive proprietary storage that needs an entire IT team to
manage! Blackmagic Cloud Store has been designed for multiple users and can handle the
huge media files used by Hollywood feature films. You can also have multiple Blackmagic
Cloud Stores syncing the media files with your Dropbox account so that everyone has
access to the media files for the project.

To find out more about these exciting workflows, visit blackmagicdesign.com/products/

davinciresolve/collaboration

Introducing Blackmagic Cloud
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Lesson 1

Getting Started:

The Fusion page in Resolve contains
all the tools you need to create world-
class visual effects. Instead of the
timeline you might be used to from
editing, Fusion uses nodes.

Working with nodes is no more difficult
than working with video clips on a
timeline. It is, however, a whole new
way of doing things. As you work
through this quick-start lesson, give
yourself some grace to adjust to

this new method of putting images
together. Once the node-based
paradigm becomes cemented in your
understanding, the rest of this training
guide will come easily.

Throughout this book, we'll delve into
some powerful techniques for creating
compelling visual effects (VFX), but

it all begins with a foundational
understanding of the Fusion interface
and its basic building blocks: nodes.

_earning the
-usion Page

Time

This lesson takes approximately
90 minutes to complete.
Goals

Exploring the Fusion Interface
Combining Images Using Nodes
Adding Effects

Understanding node flow
Working with Masks

Secondary Color Correction
Animating with Keyframes
Adding a Vignette

Returning to the Timeline

Lesson Review

16
23
26
28
34
35
36
37



Exploring the Fusion Interface

In most editing systems, you put together your rough cut and then refine your edited
versions in the edit page timeline. If you need compositing or motion graphics work, you
export frames, open up different software, import the frames, and then render out the
results for importing back into the edit timeline. Fusion does away with this: a single click
takes you from the timeline and into the creation of your effects.

Open DaVinci Resolve, right-click in the Project Manager, and choose Restore
Project Archive.

Navigate to the R18 Fusion Guide Lessons folder.

This folder contains four DaVinci Resolve Archives and a separate “Fusion files” folder,
all of which we will use throughout the exercises in this guide. We'll start with the
Getting Started archive.

Select the (DaVinci Resolve Archive file) and click Open to add the
Getting Started project to the Project Manager.

Open the Getting Started project from the Project Manager and then select the
edit page, if necessary.

From the main menu bar, choose Workspace > Reset UI Layout.

If you accidentally alter your interface and find it hard to follow along,
selecting Reset UI Layout will return the interface to its default state,
which—for the most part—should match the layout used throughout this book.

The timeline in this project includes a shot that requires some visual effects work.
In the timeline, move the playhead to the start and play through the clip.

This is a scene from the sci-fi short SYNC. In this scene, a robot courier receives a hard
drive directly into a drive slot embedded in its back. Your job is to add the robot's CG
“cavity” to the live-action footage.

The term CG stands for “computer generated” and typically refers to
images created in a 3D animation package such as Maya or Blender. An older
form of the term is CGI, or “computer-generated imagery.”

Getting Started: Learning the Fusion Page


https://hazfilm.com/sync-a-proof-of-concept-robots-data-cyberpolice

Position the playhead over the center of the clip.

Click the Fusion page button or press Shift-5.
That's all it takes to bring a single shot into the Fusion page where you can apply effects.
Before you start creating those visual effects, let's get familiar with the Fusion page.

The page is organized into four main sections. The two viewers across the top display
the images you're working on. Below the viewers, a toolbar includes the most used
effects (also called tools). The lower work area, called the Node Editor, is the heart of
the Fusion page where you construct your effects. Finally, the Inspector is to the right.

In the Inspector, you can

The left and right viewers display and manipulate the
can show different images or parameter of any selected effect
effects from your composite. or tool in the Node Editor.

(B Divircs Resenve St - Cenmzsranea g x

The toolbar has buttons for The work area can show any
adding commonly used effects combination of the Node Editor,
or tools to the Node Editor. Keyframes Editor, or Spline Editor.

Exploring the Fusion Interface



By default, the work area displays the Node Editor. Unlike the edit page, Fusion doesn't
apply effects directly to clips in a timeline. Instead, it uses a node graph (sometimes
called a node “tree”) in which each image or effect is a node, as represented by a
rectangular icon in the Node Editor.

Mediain1 B N MediaUut1 [ ]

As mentioned at the start of this lesson, nodes aren’t hard to understand; they just
require a different way of thinking and take a little time to get used to. Before we dive
into learning about nodes, let’s learn how to navigate around the interface.

Mouse and keyboard commands in the Fusion page are “context sensitive”; the same key
presses or mouse clicks can produce different results depending on where your mouse
pointer is positioned in the interface. For the following exercise, pay attention to where
you're being asked to position the mouse pointer before commencing the action.

With the mouse pointer positioned over an empty gray space in the Node Editor,
hold down the middle mouse button and drag to pan the node tree into the center
of the panel.

While there are workarounds when using other input devices, we strongly
recommend using a three-button mouse when working with the Fusion page.
Typically, pressing down on the scroll wheel of a standard mouse acts as a
middle mouse button click. A pen and tablet input device is also an excellent
choice for working with Fusion, although for brevity we will only cover the
mouse commands in these lessons.

Getting Started: Learning the Fusion Page



It's easy to accidentally pan nodes completely out of view of the Node Editor. When this
happens, the Navigator pane appears in the upper-right corner of the editor panel.
Simply click in the Navigator pane to re-center the Node Editor view.

Medialn1

To zoom the Node Editor view, hold down the left and middle mouse buttons and
drag left and right.

Fusion

Remember when we said that keyboard and mouse commands are context sensitive?
This means you can use the same commands in the viewers.

Position your mouse pointer over the right viewer and drag with the middle mouse
button down to pan, and hold the left and middle mouse buttons down and drag left
and right to zoom.

With your mouse pointer still hovering over the right viewer, press Command-F
(macOS) or Ctrl-F (PC) to fit the image into the full area of the viewer.

There are a couple more navigation keyboard commands worth learning.

Press the + and - keys to zoom in to or out of the viewers or Node Editor in discrete steps.

Exploring the Fusion Interface



With your mouse pointer over the right viewer, press Command-1 (macOS) or Ctrl-
1 (PC) and Command-2 (macQOS) or Ctrl-2 (PC) to zoom to 100% and 200% zoom,
respectively. Press Command-F (macOS) or Ctrl-F (PC) to reframe the image to fit
the viewer in its entirety.

These same navigation commands also work in the left viewer, the Spline Editor, and the

Keyframes Editor.

Navigating in Fusion

Mac
Pan around a view: Middle mouse drag
Zoom the view Left and middle mouse drag
Zoom to 100%, 200% Command-1, Command-2
Frame the view Command-F

PC

Middle mouse drag

Left and middle mouse drag
Ctrl-1, Ctrl-2

Ctrl-F

Every clip or image file that you bring into the Fusion page is represented by a Media In
node in the Node Editor. The current Media In node represents the clip from the edit page
timeline. The Media Out node represents the final image that is sent back to the timeline
on the edit page. What flows into the Media Out node to the timeline will be the result of

all our effects work.

Getting Started: Learning the Fusion Page



NOTE If you disconnect the Media Out node from the rest of the node tree, the clip
will appear blank in the edit page timeline, since no image data is able to travel back
to the timeline clip.

In the Node Editor, click the Medialn1 node to select it. A red highlight border appears
around the node to indicate the selection. Press the 1 key to display the image in
viewer 1 to the left.

DaVinc Resolve Studic - GettingStarted

Pressing the 1 and 2 keys loads a selected node into the left and right viewers,
respectively. If you have an external broadcast monitor connected to a Blackmagic

Decklink card, pressing 3 will load the selected node to the external display.

Notice the small dots at the base of each node. A white dot in position one indicates
that the node is currently loaded in the left viewer. A white dot in position two indicates
that the node is currently loaded in the right viewer. A third dot (as shown in the
preceding figure) will only be present if an external broadcast monitor is connected
and indicates whether the node is loaded to that monitor.

The terms node and tool are used interchangeably to refer to an image-
processing operation.

Exploring the Fusion Interface



To better understand what each Media In node represents, we can add thumbnails to
the nodes.

Right-click in an empty space in the Node Editor and choose Force Source Tile Pictures.

Force Source Tile Pictures

3

- Medialn1 [ ]

When you first enable source tile pictures, you'll often see an icon in place of the clip
thumbnail. To update the thumbnail, you simply need to drag the time ruler playhead.

Medialn1 [ ]

Getting Started: Learning the Fusion Page



Click and drag along the time ruler to update the Media In node’s tile picture.

> Medialn1 LD —— L Lt 1 191V S |

It's a good idea to enable Force Source Tile Pictures by default for future projects.

Select Fusion > Fusion Settings.

B DaVinci Resolve Studio - GettingStarted
N T e Biision

=
G5 MNodes =

Fusion Sett
Medialn1 -

Exploring the Fusion Interface
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Select the Flow section, enable Source Tile Pictures, and click Save.

Fusion Settings

Force

Flow

v

Options

=: Direct Build C Horizontal

100%

Pipe grab distance

Link grab distance

Future projects will now automatically create thumbnails for the Media In nodes.

In addition to adding tile pictures, you can rename nodes to describe their function
or image.

Select the Medialn1 node. Press the F2 key and rename the Medialn1 node
BackgroundPlate.

Fusion does not allow spaces in node names (for a good reason: spaces can cause
significant problems in production automation scripts written in Python and LUA).
Instead, use the underscore character, “Background_plate,” or—as demonstrated in
the previous step—use camel case, a standard form of notation where each new word
starts with a capital (the "humps” of the camel).
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A plate in visual effects work is simply the name given to a piece of
footage. The main source footage is commonly referred to as the background
plate. Footage that has had elements removed (such as foreground actors or
unwanted production rigging) is commonly referred to as a clean plate.

Fusion’s node-based workflow focuses almost entirely on spatial relationships
between images; it's almost like time is an afterthought. However, as we saw when
we updated the thumbnail, the time ruler enables movement forward and backward
through the footage.

By default, the time ruler and all time fields on the Fusion page display
frame numbers. To display timecode, choose Fusion > Fusion Settings, and in
the Defaults panel, configure the Fusion page to do so.

The time ruler shows the entire source clip length, and the vertical yellow lines indicate
the render range, which is that portion of that clip actually used in the edit page
timeline. In this case, the entire source media appears in the edit page sequence, so
the yellow lines appear at the far left and far right of the timeline.

Drag the playhead slowly through the render range.

As you drag the playhead through the render range, the current time display (to the
right of the time ruler) displays the current frame number. To the left of the time ruler,
you can see the render range start and end frames.

As the playhead moves, a green line appears along the time ruler to indicate frames
that are cached into RAM for smoother playback. The more RAM you have in your
system, the longer the cached region for RAM playback can be.

You can assign more or less RAM for Fusion RAM playback in the
Preferences panel. The amount of RAM assigned to Fusion RAM playback is
taken from the total amount assigned to the DaVinci Resolve application.

Exploring the Fusion Interface
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Combining Images Using Nodes

It's time to start creating an effect! We'll begin by adding another clip to the Node Editor

Click the Media Pool button to open the media pool.

a DavVinci Resolve Studio - GettingStarted

Adding new media to the Node Editor is as simple as dragging it from the media pool.

Drag the DriveDoc clip into the Node Editor and position it above and to the right of
the BackgroundPlate node. Click the new Medialn node to select it (the red selection
highlight should appear around it) and press 1 to load it into the left viewer. Drag in

the time ruler to preview the clip and update the tile picture.

B DaVinci Resolve Studio - GettingStarted

GettingStarted
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With the new Medialn node still selected (it should have its red outline) press F2 and
rename it DriveDock.

To combine two nodes together, we typically use a Merge node. We'll soon learn how
to search for and add the many nodes available in Fusion. However, since the Merge
node is used so commonly, there's a special method for creating a merge.

Click the small square on the right side of the DriveDock node and drag out a yellow
connecting pipe. Place it directly over the square on the right edge of BackgroundPlate
and release the mouse.

A Merge node automatically appears, connecting the DriveDock to the BackgroundPlate.
You'll also notice that the right viewer has updated to show the composite of the
DriveDock over the top of the source footage. (That's assuming you still have the
MediaOut node loaded into it. If not, select the MediaOut node and press 2 to load it
into the right viewer.)

DriveDock It MediaOur1

Mergel  m.

The term composite refers to the result of combining two or more images
to create a final effects shot.

Combining Images Using Nodes
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Let's talk about all those arrows and connecting lines (called pipes). Firstly, it's
important to understand that it isn't the location of the connections that matter, but
rather their color. Fusion will move the positions of the various arrows around the edge
of the node to better lay out the connections. For example, dragging the DriveDock
node below the Merge node will move the green arrow to the bottom of the Merge
node and move the blue arrow to the top in its place.

v
» BackgroundPl.. m Mergel
% - .ﬁ.

»> DriveDock

In fact, you can lay out nodes however you like. As long as the connections go to and
from the same places, nothing will change in your final image (although, as we'll soon
see, keeping nodes laid out in a logical order is important for your own comprehension
as you work).

So, what do the colors of the connections mean? The green connector is the
foreground input, and the yellow connector is the background input. In other words,
the image feeding into the green, foreground input will be composited on top of the
background image feeding into the yellow input. This is the reason we now see the
DriveDock over the background plate in the right viewer.

Green, foreground input

Yellow, background input Square output

Blue, mask input

The blue input is for masking effects (we'll cover those a little later), and the small,
white square represents the resulting image output from the node.

If you accidentally connect nodes the wrong way around (the background
clip to the foreground input and the foreground clip to the background input),
simply press Command-T (macOS) or Ctrl-T (Windows) to switch them.
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While Fusion automatically “wires up” nodes as you go, you'll frequently want to
modify the pipe connections between them. Let's look at how to connect and
disconnect the pipes.

Hover your mouse pointer over the pipe connecting Merge1 to the MediaOut1 node
until the pipe highlights yellow and blue.

> DriveDock

» BackgroundPl.. m B —eeep.  MediaOutl  m
.

diaOutl.Input

Double-click to disconnect it.

> DriveDock

» BackgroundPl.. m i erge u » MediaOutl =

There is no longer a link between Mergel and the MediaOut1 node. If you still have
MediaOut1 loaded into viewer 2, you'll notice that the viewer has gone blank. There's
no longer any image data reaching the MediaOut node. Let's go ahead and reconnect
the nodes.

Click the square output icon of Merge1, drag it to the yellow input triangle of
MediaOut1, and then release the mouse.

The two nodes are connected once again, and you should see the composited image
in viewer 2 once again.

Combining Images Using Nodes
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Adding Effects

Let's look at the current composite.

Press the Spacebar to begin playback. Press the Spacebar again to pause playback
when you're done, and then drag the playhead to a frame where you can clearly see
the glowing vertical rails of blue light on either side of the CG drive bays (say, frame 65).

As the composite plays through, you'll notice that the CG we added doesn't seem to
fit in with the live-action footage. (There’s also the small issue of the man’s hands
disappearing—we'll get to that a little later.) That's because the contrast of the two
elements doesn't match. Let's color correct the DriveDock element to match the
background plate.

Drag the DriveDock node upward to create some space. You can hold down the left
and middle mouse buttons and drag left to zoom out if you need more room in the
node view.

»| DriveDock

» E‘-ack;rqund... — _ — MediaOutl m

IT ,! r ] -

Remember: moving nodes around doesn’t change the composite unless we actually
rewire the connecting pipes between them.

Make sure DriveDock is selected (outlined in red) and click the Color Corrector icon in
the toolbar above the node view.

As mentioned earlier, the toolbar gives you visual access to many of the most common
tools in Fusion.

Notice how the color corrector is automatically added directly after the DriveDock
node. Why there? Because we had selected the node prior to clicking the Color
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Corrector button in the toolbar. New nodes are always added directly after the
selected node.

DriveDock

¥ ¥
» ColorCorrect... |4

L4
[ I— Mergel [ ]

New nodes are always added directly after the selected node.

Looking at the Inspector to the right, you'll see that the Color Corrector node offers
multiple correction tools. Right now, we're only concerned with adjusting the black point,
white point, and contrast of the DriveDock element. Matching the black and white points
of a CG element can go a long way toward integrating them convincingly into a shot.

Toward the bottom of the Inspector, drag the Lift slider left and right to see its effect.

Something isn't right here. We only want to color correct the DriveDock clip, but it
seems that the entire composite is changing as we adjust the controls.

Adding Effects
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This is happening because CG elements are almost always premultiplied. Premultiplied
images need to be treated a little differently before being color corrected. We'll talk

in more detail about premultiplication in a later lesson. For now, just know that when
dealing with premultiplied images (and again, computer-generated images are almost
always premultiplied) you need to enable the Pre-Divide/Post-Multiply option in the
color corrector.

In the Inspector, click the Options button to jump to the options section of the color
corrector interface. Enable Pre Divide/Post-Multiply.

ColorCarrector! L}

Options

+  Pre-Divide / Post-}

h

Now let's dial in the black and white points of our CG, starting with the black point.
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Make sure the Color Corrector node is still selected; if not, click it to select it. Then click
back to the Correction section in the Inspector.

Inspector

ColorCorrector1

Colors

The inspector always shows the properties for the currently selected node.

Eyeballing the black and white points in an image can be a little tricky, but we can take
advantage of a handy viewer tool to help our precision.

Click the viewer 2 menu button (the three dots at the viewer's top-right) and enable
Gain/Gamma.

MediaOut1

- .
i s \ Gain/ G .' mma
: 3

Two sliders appear superimposed over the lower right of the viewer.

Adding Effects
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Drag the Gain slider to the right until the shadows in the actor’s suit have almost
completely washed out to white.

These viewer sliders don't actually color correct your shot. Rather, they temporarily
change the brightness and contrast of your viewer to help you identify details that
might be hiding in the shadows and highlights.

In the inspector, adjust the Lift slider until the shadows in the CG element match the
intensity of the shadows in the live-action actor’s suit immediately adjacent to the CG.
(Don't try to match the darker shadows around the arms; you'll end up with too big a
mismatch due to lighting differences on set.) For greater precision, click in the numeric
entry field to the right of the slider and drag left and right to adjust. In this case, it
should be a very subtle adjustment: A value of around -0.006 should work.

1.0

1.0

-0.006

1.0

In color correction, the Lift control adjusts the level of the dark pixels in an
image, while the Gain control adjusts the level of the bright pixels.

Click the small dot below the Gain slider to reset it to its default value.

Throughout Fusion, you can click these gray dots below the sliders to reset them to
their default values.
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Drag the viewer Gain slider to the left until the bright areas at the top left of the frame
are only just visible.

While it may be difficult to make out in the printed illustration, the vertical rails of light
in the CG stand out compared with the horizontal beam of light at the top left of the
frame. We need to tame the intensity of the bright parts in our DriveDock CG element.

Drag the Gain slider left until it matches the intensity of the light at the top left of the
frame, around 0.48.

Click the small dot below the Gain slider to reset it to its default value.

We've set the black point and the white point (Lift and Gain), so why does the CG still
look too dark? Well, we need to adjust the contrast of pixels between the dark and the
bright areas. We use the Gamma control for this.

Raise the Gamma control until the contrast of the DriveDock pixels looks natural, at a
value of around 1.16.

Adding Effects
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In the viewer 2 options menu (the button with the three dots), disable the Gain/
Gamma option to return the viewer to normal operation.

Things are looking much better. To see just how much better, let's temporarily disable
the color correction to see how things looked before we started.

Make sure ColorCorrector1 is selected (outlined in red) and press Command-P (macQOS)
or Ctrl-P (Windows) to disable it.

Repeat the keyboard command to re-enable the node when you're done.

The “P"in Command-P or Ctrl-P stands for “pass-through.” In this mode, the
image stream flows directly through the disabled node, bypassing it as if it wasn't
there. You can also press the toggle button that appears in the Inspector directly to
the left of the node’s name.
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Understanding node flow

Before we move on to fixing the disappearing hand, let’s pause for a moment to better
understand how nodes work. Imagine that each source image is water under pressure.
The water coming from the BackgroundPlate node is “background-colored.”

Select the BackgroundPlate node and press 1 to load it into viewer 1.

BackgroundPlate Mergel

=

One of the great things about working with nodes is that you can quickly see the

state of the composite at any point, simply by clicking through the various nodes

that make up the node graph. Here we can see the state of the composite at the
BackgroundPlate node—just the source footage with no other elements added—while
still viewing the final output at MediaOut1 in viewer 2. This makes it much easier to
troubleshoot a chain of effects in Fusion’s node graph compared to stacking and
nesting effects in a traditional timeline.

Click the DriveDock node and press 1 to load it into viewer 1.

DriveDock Mergel

-

Now we see the CG element coming out of the DriveDock node in the left viewer. If you
look carefully, you'll see that this soloed version of the DriveDock isn't as dark as the
final version in viewer 2. That's because we're looking at the footage before it passes
through the ColorCorrector node that we added in the previous section.

Select ColorCorrector1 and press 1 to load it into viewer 1.
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As soon as you pressed 1, you should have seen the image in viewer 1 darken.
That's because we're now seeing the DriveDock image after the color correction has
been applied.

The viewer always shows the processed output of the loaded node.

So, the DriveDock “water” (to work with our water-under-pressure analogy) flows

into the ColorCorrector? node. As it passes through ColorCorrector1, the “water” is
made darker by our color correction. What comes out the other side (and what we
see in viewer 1) is the darkened result. The color corrector acts like a filtration plant—
in this case, “polluting” our water, making it darker.

When it arrives at Merge1, the “DriveDock water” combines with the “Background
water” flowing in through the yellow, background input. The two streams merge

(hence the name of the node) to create a new single stream that then flows on to
MediaOut1, where it flows out and back to the edit page timeline.

And that's really all there is to it. To strengthen your understanding, let's try a little
experiment.

Hold down the Shift key and drag the Color Corrector node to the right, away from the
nodes it's connected to. Release the mouse and then the Shift key.

DriveDock

b4 v
(3 ColorCorrector

- ol

v

BackgroundPlate Mergel

A

Holding the Shift key enables you to remove a selected node (or group of selected
nodes) from a connecting pipe, leaving the pipe intact. We can also use the Shift key to
insert nodes into an existing pipe.
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Drag the BackgroundPlate node to the left to make some room. Hold down the Shift
key and drag the ColorCorrector1 node onto the pipe connecting the BackgroundPlate
to Mergel. Release the mouse and then release the Shift key.

When inserting a node using the Shift key, make sure that the connecting
pipe has changed to half blue, half yellow. Otherwise, you may simply be laying
the node over the pipe without actually connecting it to the flow.

Looking at the viewer, you'll now notice that the background looks darker, and our
DriveDock CG looks lighter. That's because the BackgroundPlate is now upstream from
the ColorCorrector node, so it is the image being color corrected. DriveDock flows into
the main stream at Merge1. It never passes through the color corrector, so its color
remains unaffected.

Continue to press either Command-Z (macOS) or Ctrl-Z (Windows) to undo the
previous commands until ColorCorrector1 is re-inserted after the DriveDock.

Understanding node flow
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Working with Masks

As mentioned earlier, dragging the playhead past frame 75 reveals a problem: since our CG
DriveDock is simply pasted over the top of the source footage, it obscures the screen-right
actor’s hand as it passes into the same region of the frame. We'll use a new technique—
masking—to solve the problem.

The media pool should already be open at the top left. If it isn't, click the Media Pool
button to reveal it. In the Media bin, drag HandRoto into the Node Editor and position
it just to the left of the DriveDock.

With the new Medialn1 node selected, press the function key F2 and rename it
HandRoto. Press 1 to load it into viewer 1, and then drag the playhead past frame 75 to
preview the animation.

B DaVinci Resolve Studio - GettingStarted

GettingStarted

HandRoto

=

-

» HandRotw

L)

Rotoscoping, or “roto” for short, is the process of drawing outline shapes around
picture elements you either want to isolate or remove. We'll learn about Fusion’s
built-in rotoscoping tools in later lessons. For now, we'll work with the provided roto
element of the actor’s hand.

If you remember when we introduced the different colors of a node’s input arrows
earlier, we called the blue triangle the “mask” input. Let's use it now.
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Drag from the output square of HandRoto to the blue, mask input of DriveDock to
create a connecting pipe.

HandRoto DriveDock

> ColorCorrector 4
]

Well, that didn't work so well. We produced the opposite result of what we were
after: instead of hiding the DriveDock CG in the area of the hand, we removed it from
everywhere else! By default, a mask input assumes you want to keep a node’s effect
in the white regions and remove it in the black regions. And that's exactly what's
happened. The DriveDock image has been masked off so that it only appears where
the HandRoto clip appears white.

This is a common problem with a common solution: we can invert the roto matte so
that the blacks become white, and the whites become black.

Select the DriveDock node. In the Inspector, click the Settings button to switch to the
Settings section. Enable Apply Mask Inverted. The hand is now masked out of the
DriveDock image.

Multiply by Mask

You won't see the inverted image reflected in the thumbnail tile of HandRoto. We
selected invert in the DriveDock node; the image coming out of the HandRoto node
is still white-on-black. It's not until the image arrives at the DriveDock node that it's
inverted. Remember: in our water analogy, we said that the water is moving “under
pressure.” It only flows in one direction, so what happens in the DriveDock when we
enable invert doesn’'t change the state of the DriveDock image “upstream” from it.

Working with Masks
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Press Spacebar to view the final clip.

Secondary Color Correction

Just when you think your shot is complete, notes will inevitably come back from the client.
After viewing the final composite, the client has decided that the blue light of the drive
dock should change to a red light as the drive bay doors open. The shot is due in 3 hours,
and the CG artist who created the animation has flown back home for the holidays.

What to do?

Thankfully, Fusion provides all the tools we need to customize the shot and create the
desired effect.

A Luma Key node isolates pixels in an image based on their brightness. We'll use one to
work with only the blue lights in the CG shot.

Move to frame 75 in the timeline and then double-click in the empty gray space of the
Node Editor to deselect any selected nodes.

So far, we've used two methods to add nodes: connecting the outputs of two nodes to
create a Merge node, and clicking the Color Corrector button in the toolbar above the
Node Editor.

Now let’s look at the most common way you'll add nodes in Fusion: the Select Tool dialog.
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Position the mouse pointer just to the right of the DriveDock and press Shift-Spacebar
to open the Select Tool dialog.

Select Tool

Handl

Type the letters LUM into the dialog.

Select Tool

Luma Keyer (LKy)

Secondary Color Correction
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As you type the letters, Fusion begins to isolate all tool names that contain those
letters. You can use the Up and Down Arrow keys to highlight different selections,
although in this case the node we want—Luma Key—is already the default selection.

Click Add to add a Luma Key node to the Node Editor.

Nodes get added at the location of the mouse pointer, hence the reason you
positioned the mouse pointer just to the right of the DriveDock before opening
the Select Tool dialog. Also, the node doesn’t automatically connect itself to any
other nodes since we had double-clicked an empty space in the Node Editor
before adding it.

Drag a connecting pipe from the output square of the DriveDock and hover it over the
center of LumaKeyer1. Hold down the Option key (macQOS) or Alt key (Windows) before
releasing the mouse.

DriveDock

> ColorCorrector
| |

If you ever get confused about which colored input is which, you can use this handy
trick to view a list of all available inputs. The Luma Key node in particular has some
unusual inputs—a Solid Matte input and a Garbage Matte input. We're only concerned
about the main Input for our purposes.

Select Input from the pop-up list.

HandRoto DriveDock

¥ ¥

LumaKeyer1

A
(3 ColorCorrector]
[ |

Select LumaKeyer1 and press 1 to load it into viewer 1.
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In the Inspector, drag the Low and High knobs in the range slider to around 0.32 and
0.78, respectively.

LumaKeyer1

B

W

Controls ~ Settings

Luminance

The range slider is the primary method for selecting the low and high end of the range
of pixels that will be isolated by the luma key. At this point, viewer 1 should display only
the blue lighting of the DriveDock element, along with faint highlights on the chassis.

We can use this to mask off the area where we want to apply color correction.

Select Mergel and press Shift-Spacebar to access the Select Tool dialog. Type COL, and
then press the Down Arrow key to select a Color Corrector node. Press Return/Enter,
or click Add to add it to the node graph.

A new Color Corrector node is added directly after Merge1, since Mergel was the
selected node prior to accessing the Select Tool dialog.

Secondary Color Correction
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In the Inspector, drag the puck (the circle labeled “M") at the center of the color wheel
all the way to the right, tinting the image red.

MediaOut1 Inspector

ColorCorrector2

We've succeeded in turning the entire composite red. Now let's mask off the color
correction so that it only affects the pixels we isolated with our Luma Keyer.

From the output square of LumaKeyer1, drag a connecting pipe over the blue, mask
input of ColorCorrector2 and release the mouse.

The red color correction is now isolated to only the bright portions of the robot's back.
Let's blur the luma key a little to create more of a glow effect.

Select LumaKeyer1, press Shift-Spacebar, and type BLU to select and add a Blur node
directly after LumakKeyer1. Press 1 to load the Blur node into viewer 1 (Make sure
MediaOut1 is still loaded into viewer 2. If not, select it and press 2.)

Pressing 1 or 2 when a selected node is already loaded in that viewer will
“unload” the viewer, leaving a blank gray. Just press the viewer number again
to reload it.

In the Inspector, set the Blur Size to around 8.

By blurring the mask, we've inadvertently “washed out” the strength of
ColorCorrector2. Let's fix this by increasing the intensity of the color correction.
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Select ColorCorrector? to load its properties into the inspector. In the Inspector, drag
Saturation to 2.0 and Gain to around 1.7

We're back to the same color strength, but we now have a little glow around the edges
of the light, thanks to the blur.

GettingStarted

Rurl Mediaut1

Secondary Color Correction
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Animating with Keyframes

We've taken care of half of the notes from the client. Now we need to animate the light
changing from the original blue to our new red as the drive doors open. They begin to
open at frame 55 and are completely open at frame 70.

Move to frame 70 and select ColorCorrector2. Click the Settings button to switch to the
Settings section.

ColorCorrector2

At the very top of the Settings tab is a Blend slider. You'll find these in the Settings tab
of every node. They allow you to choose how much of the node’s effect to blend in to
the incoming image. If you're an editor, think of blend as a cross dissolve: a blend value
of 0.0 will output the unaffected source clip; a value of 1.0 will output all the “affected”
version at full strength. A value of 0.5 will output a mix: 50% unaffected source clip and
50% affected version.

Drag the Blend slider to see the effect.

Click the diamond to the right of the Blend slider and drag the slider all the way to 1.0.
The diamond changes color.

When you clicked the diamond button, you enabled auto keyframing, indicated by the
change of color. When keyframing is enabled, Fusion automatically sets a keyframe at
the current frame. From now on, whenever you move the Blend slider, Fusion will set a
keyframe at whatever frame your playhead happens to be set to.

Move the playhead to frame 55. Drag the Blend slider to 0.0.

Notice that as soon as you dragged the slider, the diamond changed color again,
indicating that you've set a keyframe at the current frame: frame 55.
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We'll cover editing keyframes in detail in later lessons. For now, if you
make a mistake, just undo (Command-Z on macOS, Ctrl-Z on Windows) back to
before the error.

Drag the playhead from frame 55 to frame 70. The light changes from blue to red as
the Blend value animates from O to 1.0.

Adding a Vignette

For a final “flourish,” we'll add a vignette effect to the shot.
Select ColorCorrector?2.

Press Shift-Spacebar to access the Select Tool dialog and type VIG, and then press
Return or Enter to add the Vignette tool.

Drag the Size slider up to around 0.8 and bring Softness down to about 0.4.

v ¥

s LumaKeyer1

Mergel

Adding a Vignette
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Returning to the Timeline

The beauty of Fusion existing as a page in Resolve is that returning from performing
effects work is as simple as clicking back to the edit page. For the smoothest playback from
the timeline, let's enable smart caching.

Click the Edit button at the base of the interface or press Shift-4 to return to the
edit page.
Select Playback > Render Cache > Smart to enable smart caching.

When smart caching is enabled, Resolve will take advantage of idle CPU cycles to
render a cache file of the Fusion effects work. As you watch, the bar at the top of the
timeline will turn blue, indicating that the clip is fully cached and ready to be played
back smoothly (@assuming your cache directory is set to a sufficiently speedy drive—
you can set its location in the Media Storage section of System Preferences).

Playback Fusion

v Em .1 rt k‘
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Lesson Review

In the Fusion page, how can you display the output of a node in viewer 1?
When adding a new node, where is the node added?

What node would you use to combine two images?

What is the yellow input on a Merge node?

True or false? When you're on the Fusion page, you can disconnect the Media Out
node because you have no use for it.

Lesson Review
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In the Fusion page, to display the output of a node in viewer 1, select the node and
press the 1 key.

The new node is added directly after the selected node in the Node Editor.
A Merge node is used to composite two images.
The yellow input on a Merge node is for the background input.

False. The Media Out node is always the last node connected, and it renders the
Node Editor results back to the edit page timeline.
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Part |

Visual Effects
Creation

In this section, you'll learn the foundational techniques of visual effects compositing.
Tracking, keying, working with mattes, and basic color manipulation are the building
blocks for the majority of effects shots. You'll become familiar with these tools in
Fusion as you work through some of the most common VFX tasks: split-screen
fixes, sky replacements, sign replacement, and green-screen compositing.
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Lesson 2

Compositing
Split Screens

The Fusion page excels at creating
photorealistic visual effects
composites. The next four lessons

in this book focus on visual effects
compositing, which is primarily about
combining multiple, distinct images
to make a believable new whole.

The goal of visual effects compositing
is to convince the audience that a
single, live-action camera recorded the
resulting shot live, regardless of how
fantastical the subjects.

Time

This lesson takes approximately
45 minutes to complete.

Goals

Using Layers from the Edit Page
Tracking in the Fusion Page
Drawing a Matte

Aligning the Clips Using Nudging
Restoring Camera Motion

Lesson Review
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One of the most critical aspects when compositing is to have all the different elements
follow the same camera motion. These are often called match moves because you analyze
the background clip’'s movement and apply it to a foreground clip or vice versa. The
Fusion page provides three primary techniques for extracting the camera’s motion: point
tracking, planar tracking, and 3D camera tracking. In the course of this book, you'll learn
all three. In this lesson, we'll begin with the standard point tracker. Although not the most
sophisticated tracking tool, the point tracker is a real workhorse because it works on the
broadest range of shots.

This first visual effects lesson will analyze the motion in two shots to create a split-screen
effect. Now, when we say split screen, we are not talking about a simple picture-in-picture
effect. A split screen in visual effects terms is a technique where different takes are
combined to make one better overall take. For instance, let's say we have two actors in

a shot. One actor might deliver an excellent performance in take 1, while the other actor
delivers their best performance in take 2. The director might want to combine the two
performances and make them appear as a single take.

Original clip and completed split screen for Lesson 2.

Using Layers from the Edit Page

Part I of this book uses a new project for its four lessons. You'll start by restoring a new
archive that includes all the media, bins, and timelines you'll need.

Open DaVinci Resolve 18, and in the Project Manager, right-click and choose Restore
Project Archive.

In the navigation window, go to the R18 Fusion Guide Lessons folder and open
Click the Edit button or press Shift-4 to return to the edit page if you're still on the

Fusion page.

From the Timelines bin, double-click Part 1 -START.
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Move the playhead over the first red marker in the timeline. Use Cmd + and
Cmd - (macOS) or Ctrl + and Ctrl - (Windows) to zoom the timeline in and out.

b ﬁﬂn ﬁ—h. ﬂ“fn

Take 1.mov
- O Y - O
» » e

Take 2.mov

This first edit consists of a driver and a passenger in a car. The passenger is listening
to the driver, nodding with encouragement. Video track 1 has a much better view of
the driver speaking but not of the passenger’s reaction.

In the timeline, select the clip on video 2, press D to disable it, and view the driver
speaking and the less affirming passenger.

Press D a second time to enable the foreground clip again.

Your job as the visual effects artist is to perform a split-screen effect. The goal
is to combine the driver speaking from V1 with the nodding passenger’s better
reaction from V2.

To start the split-screen effect, you must bring both takes into the Fusion page. To bring
more than one clip from the edit page into the Fusion page, you must create a Fusion clip.

Using Layers from the Edit Page
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Select both clips in the timeline. Right-click the selected clips and choose New Fusion
Clip at the top of the menu.

Fusion Clip 1

A Fusion clip is created in the timeline and added to the selected bin. The two layers
are collapsed into the container.

You can display all the layers of a Fusion clip in the edit page timeline by
right-clicking the Fusion clip and choosing Open in Timeline.

With the playhead still positioned over the clip, click the Fusion page button or
press Shift-5.

The two layers are brought into the Node Editor and combined in a Merge node.

Move Medialn2 above Mergel and Medialn1 to the left of Merge1.

> Medialn1 | ] » Mergel m

Y

This creates a more “readable” layout, where the background clip is on the left and the
new, foreground clip is added to the horizontal stream from above.

NOTE Feel free to rearrange the nodes within the Node Editor as you continue
to add nodes in this lesson. In the screenshot above, we've already moved
Medialn1 a little so that it doesn’t overlap with Medialn2.

Compositing Split Screens



The Medialn1 node represents the clip from video track 1, and the Medialn2 node
represents the clip from video track 2. The clip from video track 1 connects to the
Merge node’s background, and video track 2 connects to the foreground input.

To quickly identify each Media In node and what they represent, you can change their
default names to be more descriptive of the contents.

Rename Medialn1 to DRIVER and Medialn2 to PASSENGER.

Node names cannot contain spaces, but you can use the underscore
character to separate words.

Now, you'll continue with this split-screen composite by tracking the PASSENGER clip and
using that tracking data to stabilize it.

Image Processing across DaVinci Resolve Pages

The layout of the pages at the bottom of the DaVinci Resolve interface represents
the project workflow. Media is ingested in the media page, assembled into a
timeline edit or cut page, undergoes compositing in the Fusion page, and is then
graded in the color page before rendering out through the deliver page.

Viewer results

SRS TR empe ok

. Edit page Fusion comps
Source media Source media plug-ins Fusion color page
compound clips comps grades

This order of operations also corresponds to the image-processing pipeline, with
some exceptions. The video signal of the source media in the edit page (or cut
page) flows to the Fusion page, where it is processed and output to the color
page. However, if an effect (Resolve FX or OFX plug-in) is applied in the edit page,
it will not appear in the Fusion page but will instead appear on the color page. Edit
page effects are applied to the image data signal after it has left the Fusion page.
The only exception to this is resizing and repositioning in the edit page. To force
visibility of an edit page effect in the Fusion page, you can convert the clip into a
compound clip on the edit page timeline.

Using Layers from the Edit Page



Tracking in the Fusion Page

The easiest way to create a split-screen effect is to remove all camera motion from both
the PASSENGER and the DRIVER clips. You want to eliminate the camera motion so that
later you can re-apply camera motion to the new composite from whichever take you
prefer. To remove camera motion or stabilize a clip, you need to track the clip using a
Tracker node in Fusion.

Select the PASSENGER node and then open the Effects Library.

Press Shift-Spacebar to bring up the Select Tool dialog, type TRA, and then press
Return/Enter to add the selected Tracker tool. It is added after the selected
PASSENGER node.

PASSENGER

» Tracker]

DRIVER T — Mergel

?

Select the Tracker node and press 1 to see it in the viewer.

The first step in setting up the tracker is to position the tracker over a high-contrast
pattern in the frame that includes the motion you want to track. Because you want to
remove the camera motion, you identify objects in the frame that move only because
of the camera moves.

Move the playhead to the start of the render range.

You can press Command-Left Arrow (macOS) or Ctrl-Left Arrow (Windows)
to move the playhead to the start of the render range.

When the mouse pointer is over the tracker outline in the viewer, the tracker displays
two boxes. The inner box identifies the high-contrast pattern that the tracker should
follow, and the outer box is the search area. You can position the inner pattern box by
dragging it from the upper-left corner handle.
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The tracker automatically chooses the clip connected to its background
input as the clip to track.

In viewer 1, drag the handle in the upper-left corner of the pattern box to position the

tracker over the lock on the back door.

The pattern box expands and displays a magnified view of the area you are over, so
you can be precise with your selection. The door lock is a high-contrast, well defined
area that stays in the shot the entire time. This makes it a good tracking point.

When the door lock is centered in the magnified view, release the mouse button.

The outer box of the tracker is the search box. As the tracker moves frame by frame
through the clip, it looks for the pattern you have identified in the pattern box. The
larger the search area is, the longer the tracking analysis takes. On slow-moving
objects, the pattern probably won't move far from one frame to the next, so you can
usually create a relatively small region for the search box. When you have a fast-
moving object, you might need to increase the search box size.

Because the camera does not move very quickly in this shot, the tracked objects will
not move very far from one frame to the next. So, we can leave the search box at its
current size.

When stabilizing a shot, a single point stabilizes only the translation movement (up/
down and side-to-side) of that pattern in the frame. The pattern can still scale and
rotate. You need at least three points to prevent an image from moving, scaling,
and rotating.

Tracking in the Fusion Page
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In the Inspector, click the Add button twice to add two additional tracker points to the
tracker list.

Tracker List

4

W T .
' Tracker 3

Show  Selected Tracker

You can double-click a tracker in the Tracker List and rename it for
organizational clarity.

In viewer 1, drag Tracker 2 over the highest-contrast area of the seatbelt attachment to
the right of our passenger’s head.

The high-contrast parts of the car are good tracking points. They are “nailed to
the set,” meaning they do not move except for the fact that the camera moves.
The passenger and the driver are not nailed to the set, so they would make a poor
choice for tracking in this shot.
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Selecting a third tracking point gets trickier. There are not too many other high-
contrast points in the car. Because details outside the car (looking through the
window) are at a distance, tracking anything in the window could be impacted by
camera parallax. So, we are limited to picking a point inside the car. Although in most
cases shadows are a last resort when tracking since they can move independently of
the camera, the shadows on the door to the left of our passenger will work in this clip.

Parallax occurs when camera movement reveals one object behind
another that was previously obscured by the foreground object.

Drag Tracker 3 over the sharp triangular shadow on the door.

To begin the tracking process, you use the tracking analysis buttons along the top of
the Inspector.

Click the Track from First Frame button to begin the tracking process.

RoH

Trackers Of

Viewer 1 displays the progress of the trackers until the analysis is complete. A dialog is
displayed, showing some information about the tracking process.

Click OK in the dialog to confirm the completion.

You now have three reliable trackers that follow the camera movement. However,
tracking is not the effect; it is only the means to an end. The next step is to put that
tracking data to use in stabilizing this clip.

Tracking in the Fusion Page
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After the tracking analysis completes, you can then change the tracker’s operation mode
to utilize the tracking data.

In the tracker’s Inspector, click the Operation tab.

Tracker1

s Opergtion Options  Setti
p! L.?f ptic

Operation  None

The Operation tab is where you determine how the tracking data gets used. The
Operation menu at the top of the Inspector contains all available options.

From the Operation menu in the Inspector, choose Match Move.

The Operation menu options depend on the inputs connected to the Tracker node. To
stabilize a clip, you must have the clip connected to the background input, as we have
here. Then you set the match move operation to apply to the background.

From the Merge menu, choose “BG only.”

Tracker1

Trackers Operation Options Settings

Operation Match Move

Merge  FG over BG

Apply Mode  BG only

Operator

Subtractive/Additive

Play the clip to view the stabilized clip in viewer 1.

As the clip plays in viewer 1, notice that it reveals some of the checkerboard
background on the left side of the frame. Stabilization works by taking the camera
motion from the tracker, inverting that motion, and applying it to the same clip.
For instance, if the camera moves down, the tracker pushes the entire frame up to
offset the move.

However, this exposes the background because the clip is the same resolution as
the output. You'll have to fix this at some point, but for now you just want a very
steady clip.
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There are many methods you could use to perform this split screen, but the most
straightforward is to make sure both clips are stabilized. This makes it much easier to
combine the two clips. Now that you have some experience stabilizing with the tracker,
you can repeat the same steps to stabilize the DRIVER clip.

In the Node Editor, select the DRIVER node, press Shift-Spacebar to access the Select
Tools dialog, type TRA, and add the tracker to it.

Select the Tracker 2 node and press 1 to see it in the viewer.

PASSENGER

ith
[

!
» Trackerl

v
DRIVER » Tracker2 [ Mergel
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In the Inspector, add two more trackers to the tracker list and then position all three
trackers in roughly the same locations as you did for the PASSENGER clip.

Once the trackers are correctly positioned, click the Track Forward button.

In the Inspector, click the Operation tab, and from the Operation menu, choose Match
Move, and then from the Merge menu, choose “BG only.”

You now have two perfectly stabile clips. With the camera motion removed, you can draw
a simple mask shape to isolate the halves of each clip you want to use.

Drawing a Matte

A considerable part of compositing has to do with drawing mattes, sometimes called
rotoscoping. Mattes help you isolate specific areas of your image so that effects are
applied only where they are needed.

In the “Getting Started” project, we were working with a CG element that had an alpha
channel—a special, hidden channel of image data that defines which parts of an image are
solid and which parts should be transparent. (We'll cover alpha channels in more detail in a
later lesson.)

Drawing a Matte
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Since there is no alpha channel in either of these pieces of footage, we need to create a
matte that will define which parts of the PASSENGR clip should be solid and which parts
should be cut away to reveal the DRIVER clip.

Select the Merge node and press 2 to view the merge in viewer 2.

The merge has the PASSENGER clip connected as the foreground, so viewing the
merge will only display that clip until we apply the mask.

Drag the playhead to the start of the render range.

It's best to add the polygon mask shape while you're positioned at the start or end of
a render range because mask shapes auto-animate—meaning, if you later change the
shape on any other frame, the shape interpolates (changes shape over time, morphing
from the start shape to the new, changed shape). This makes it very quick to rotoscope
a moving object but can be confusing if you're unaware of the behavior.

To disable auto-keyframing on spline shapes in the Inspector,
right-click over the “Right-click here for shape animation” label and choose
Remove Polygon#Polyline.

With Mergel selected, select the Polygon shape tool from the toolbar directly above the
Node Editor. Drag the resulting Polygon node below Merge1 for better organization.

Polygon

When a Polygon mask tool is selected, drawing tools appear above the viewer, and you
can begin to draw a shape even before connecting the node into your composite.

To increase the size of the viewer and see more detail around the area you're
rotoscoping, position the mouse pointer on the line between the transport controls
and the toolbar, and then drag down to increase the viewer's size.

We won't need two viewers for this task, so we can gain more working space by just
viewing a single viewer for the Merge node.
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With the Merge node still viewed in viewer 2, click the Single Viewer button located in
the upper-right corner of the viewer.

Now, viewer 2 takes up the entire top half of the screen to give you a good canvas on
which to draw your matte.

NOTE The terms matte and mask are often used interchangeably. In this
book, matte refers to a grayscale image that identifies transparent and opaque
pixels. A mask is the application of a matte. That is, you use a matte to mask off
part of an image.

To ensure that you draw the matte around the frame, move the mouse pointer over
the viewer. Hold down the Command (macOS) or Ctrl key (Windows) and scroll the
middle mouse wheel to zoom in until you are able to see around the entire frame.

To draw a polygon shape around the left side of this image, you'll need no more than
10 to 15 control points. You want to use as few points as possible but as many as
needed to cover the area correctly.

You can always add and subtract points later, but the more points you add,
the more you'll have to manage.

Select the Polygon node, and then in the viewer, click in the upper-left corner of the
frame to add a control point. Then, move your pointer down to the lower-left corner
and click to create a spline running down the left side of the frame.
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You don't need to add many points along the straight edges of the frame, because
they are straight. However, you'll want to be more detailed as you continue the shape
between the characters.

Move the mouse pointer across the bottom of the frame until you reach the driver’s
blue shirt, and then click to add a point under his blue shirt.

Holding the middle mouse button and dragging in the viewer will pan the
viewer, making it easier to see various parts of the frame while you are zoomed

ben the passenger’s yellow top and the driver’s blue shirt, and
ontrol point just before they separate.

Add another point at the top of the sun patch on the back seat.
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Move your mouse pointer up and over to the left to the lower-left corner of the back
door window.

Move your mouse pointer halfway up the window frame between the front and back
door and click to add a control point just before the driver’s hair overlaps with the
window frame.
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Move your mouse pointer up and into the center of the window frame to avoid the

driver’s hair.

Add a point at the top of the frame and then move your mouse pointer over the first
point you started with.

N =

When the mouse pointer displays a circular icon, click the first point you added or
press Shift-O to close the shape.

Many problems occur when you assume that you have closed a shape, but
itis still open. Making sure you close the shape either by using the keyboard
shortcut (Shift-O) or clicking directly on the first control point will save you a
considerable amount of troubleshooting time later.
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Your new polygon matte is now “choosing” to Merge only the passenger (the screen-
left actor) from the PASSENGER clip over the top of the passenger in the DRIVER clip.

PASSENGER

v
DRIVIR - » Tracker2 3 > —_— T

Select DRIVER and press 1 to load it into viewer 1. Select PASSENGER and press 1 to
load it into viewer 1. Finally, select Mergel and then press 1 to load it into viewer 1.

You've just confirmed that the split screen is working: the screen-right driver actor
from DRIVER appears in the final composite at Merge1, and the screen-left passenger
actor from PASSENGER is the version of that actor appearing in the final composite.

Select Polygon1 and press 1 to load it into viewer 1.

Paolygon1

It's worth pausing for a moment here to get a better understanding of what's going

on. We've drawn a matte using the polygon node that essentially decides where
Merge1 will “do its job,” and where it won't. In the white area of Polygon1, Merge1 will
"work.” In other words, it'll do its job of compositing the pixels of Merge1’s foreground
input—PASSENGER—over the top of the pixels of Merge’s background input—
DRIVER. But where the matte is black, Merge1 will not apply any effect. In other words,
it will leave the pixels coming into its background input unchanged. The result is that
we get the screen-left actor of PASSENGER composited over the top of the existing
version of her in the DRIVER take, but the screen right actor remains unchanged.

Drawing a Matte
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Aligning the Clips Using Nudging
At this point, we could call the shot “final” and send it on for review.

Make sure Mergel is loaded into viewer 2. Press Spacebar to play through the sequence.

There are two remaining problems: Firstly, we've removed all motion from the frame
by stabilizing both shots. Directors like motion in the frame, so the director won't

be happy with us removing it. Secondly, there’s no guarantee that each take started

with the camera in exactly the same position, so there's a slight misalignment in the

positioning of the two stabilized shots. Look carefully at the border between the two
actors and you'll notice a “tear” resulting from the misalignment.

Let's start by fixing the latter issue: aligning the starting position of the two shots.

Double-click the connecting pipe between Polygon1 and Merge1 to disconnect it.

» Polygonl ©

We're just temporarily disconnecting Polygon1; when we're done aligning the clips,
we'll reconnect it.
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Move the playhead back to the start of the timeline. Select Merge1, and then in the
Inspector change the Apply Mode to Difference.

Sometimes you'll find that you need to “break” a shot to perform useful adjustments.
Here, we've changed the method by which Fusion composites the foreground and the
background. That's what apply modes do: they blend foreground and background in
different (and often artistically interesting) ways. In Difference apply mode, whenever
overlapping foreground and background pixels are the same, they'll appear black.
Wherever they're different, they'll appear as light. Now we should expect the actors to
stand out, since they'll be in different positions in the two different takes. But all things
considered, the background of the car should be identical in both shots.

In the Inspector, click and drag in the Center X and Center Y numeric entry fields

to nudge the alignment of the images until the majority of the car background

turns black. For fine adjustments, hold down the Command key (macOS) or Ctrl key
(Windows) while dragging. For extremely coarse adjustments, hold down the Shift key
(though in the case of this shot, such large adjustments should be unnecessary).

Aligning the Clips Using Nudging
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Due to lens distortion and subtle light changes between takes, you'll never
get perfect alignment of the shot throughout the frame. Focus instead on
getting alignment where it counts. In the case of this shot, that's toward the
center of the shot where the split screen divides between the two actors.

You'll find that you'll need to go back and forth between the X and Y, since adjustment
in X will negatively impact the alignment in Y, and vice versa. Alternately adjusting X
then Y will home you in on a final optimal alignment. Final values of 0.501 and 0.5199

should produce the desired alignment.

With alignment complete, return Merge1’s Apply Mode to its Normal blend state and
reconnect Polygon1 to the blue, mask input of Merge1.

For the most part, the tear between the actors is fixed. We'll add a little blur to the
matte to soften the transition and hide any remaining mismatch due to shadows and
lighting differences between the takes.
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Select Polygon1. In the Inspector, drag Soft Edge to around 0.02 to smooth the border
between the two takes.

Polygon1

If you notice that the screen-left actor is bleeding into the split-screen border, move
back to the start of the sequence (where you initially created the shape) and drag the
border points of the shape to eliminate the problem.

Restoring Camera Motion

Let's address the other issue now: reintroducing movement to the frame. Restoring
camera motion is done by reapplying the tracking data, but instead of steadying the clips
as we did to stabilize them, you will now unsteady the composite.

Choose Workspace > Reset Ul to return to a dual viewer setup.

You should now have two viewers with the Tracker 2 in viewer 1 and the Merge node
displayed in viewer 2.

Select the Merge node, press Shift-Spacebar to open the Select Tool dialog, type TRA,
and then select Transform (Xf).

\ 4 b4

[» Tracker2 Transform1 MediaOut1
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The Transform node will be used for two final steps. First, the Transform node will
be used to reapply the tracking data, and secondly it will allow us to scale up the final
composite a tiny bit to hide some imperfections around the edges.

Restoring Camera Motion
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Select the Transform node and press 2 to see the results in viewer 2.

When you have tracked an image with a Tracker node, the data from the tracker is
published. This allows other nodes to reuse the same data without you having to copy
and paste the Tracker node multiple times throughout a composition. You access

this published tracking data by right-clicking over a parameter in the Inspector or the
onscreen control in the viewer and using the Connect To menu.

In the viewer, right-click over the transform’s center point control.

At the bottom of the contextual menu, choose Tranform1: Center > Connect To >
Tracker2 > Unsteady Position.

Connect To

Tracker2

Unsteady Posi

The Connect To submenu is used to link various published parameters or data to other
parameters. Since we added a tracker to the PASSENGER clip and a second tracker to
the DRIVER clip, both tracker’s published data is shown in the menu. This allows you

to reapply the camera motion from either clip.
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Choosing Tracker 2 takes the camera motion from the DRIVER clip, and choosing
Unsteady Position applies the tracked motion data to the transform.

Play the composite to view the split screen.

For optimal quality, it's best to try to construct your node trees so that
nodes that transform images are placed next to each other in the node tree.
Specific nodes that transform (scale, position, rotate) an image will maximize
quality by performing the transforms from adjacent nodes in one pass. This
is called concatenation. The Transform, Tracker, DVE, and Merge nodes all
concatenate as long as a mask is not connected to any of the nodes.

The last piece of the puzzle in finishing this composite is to scale the final result so the
image fills the frame. Because of the stabilization, you can see that the left edge and
the top of the frame reveal the background. The way to correct this is to scale the final

composite to fill the image.
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In the Inspector, increase the Size control to around 1.02 in order to fill the frame with
the finished composite.

Play the composite to view the final shot.

Your split-screen composite now has a better overall look with the added camera motion.
You've taken these two shots from the edit page timeline into a completed composite,
using a couple of Tracker nodes, a simple Polygon mask, and a Transform.

m=p Transform1 R R —— MediaUutl [ ]

Completed node tree for Lesson 2.
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Lesson Review

True or false? A Fusion clip is used to take multiple timeline layers from the edit page
into the Fusion page.

True or false? Green is the color of the Effect mask input on a Matte control node.

True or false? You must click the Keyframe button in the Inspector to animate a
Polygon matte.

True or false? The Tracker is used to stabilize clips in the Fusion page.

True or false? In the Merge menu of the Tracker’s Operation tab, choosing “BG
only” will stabilize the clip that is connected to the yellow background input of the
Tracker node.

Lesson Review
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True. A Fusion clip is used to take multiple timeline layers from the edit page into the
Fusion page.

False. The green input on any node is the foreground input.
False. No button needs to be enabled. Polygon mattes auto-animate by default.
True. The Tracker is used to stabilize clips in the Fusion page.

True. In the Merge menu of the Tracker's Operation tab, choosing “BG only” will
stabilize the clip that is connected to the yellow background input of the Tracker node.
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Lesson 3

Replacing a Sky

One of the most common problems
with shooting outdoors is the sky.
Either the location or time of day you
are shooting lacks the drama your
scene calls for, or your camera lacks
the dynamic range to expose the
foreground without overexposing the
sky. The good news is, as far as visual
effects go, sky replacement isn't all that
difficult once you know the basic node
structure.

Time

This lesson takes approximately
50 minutes to complete.
Goals

Retaining a Clip’s Resolution

Controlling a Composition’s
Resolution

Compositing Using the
Darken Apply Mode

Adding Effects from the
Effects Library

Fixing Holes in a Key
Embedding Alpha into an Image
Tracking the Sky into Position
Fixing Interrupted Trackers
Blending In the Original Sky
Practice Exercise

Lesson Review
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77

79
82
84
87
91
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In this lesson, you'll learn an indispensable node structure for a sky replacement.
During the process of learning how to perform a sky replacement, you'll also look closer
at compositing images of different resolutions.

Completed sky replacement for Lesson 3.

Retaining a Clip’s Resolution

This lesson will continue with the same project you restored in the previous lesson. We'll
open the same timeline and begin with the clips located at the second red marker.

Open DaVinci Resolve 18 and, from the Project Manager, open the
project.

In the Timelines bin, double-click the timeline.

Move the playhead over the second edit and the second red marker.
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DaVinci Resolve in general, and the Fusion page specifically, are resolution
independent. You can efficiently work with any number of elements at different
resolutions. But knowing what resolution independence means and dealing with it
in your node tree are two very different things. When constructing composites with
mixed resolutions, you must be aware of how images are handled, not only between
the edit and Fusion pages but also within the Fusion page itself.

Like the clips you worked with in Lesson 2, this second edit in the timeline also includes
two layers.

Select the foreground clip on video track 2 and press D to disable this clip in the viewer
and reveal the sky with rainbow clip on video track 1.

In this two-layer composite, the sky with rainbow is a still photo with a resolution of
3888 x 2187, and the foreground clip on video track 2 is 1920 x 1080. The timeline is
also set to 1920 x 1080 HD.

As you can see, the sky with rainbow has some buildings along the bottom, which we
do not want to see in the sky replacement composite. Since this is a high-resolution
photo, we can scale it up without losing any quality.

Retaining a Clip’s Resolution 69



5 Select the sky with rainbow clip on video track 1 in the timeline, and then in the
Inspector, use the zoom controls to scale up the clip to about 1.5.

Because Fusion is fully integrated into DaVinci Resolve, the layering and transforms
you perform on the edit page timeline carry over to the Fusion page.

6 Select the foreground clip on video track 2 and press D to enable this clip in the viewer.

7 Select both clips in the timeline, and then right-click and choose New Fusion Clip
from the menu.

As you saw in Lesson 2, a new Fusion clip is created in the timeline and added to the
selected bin. The two layers are collapsed into a container and can be brought into
the Fusion page.

2 Position the playhead over the new Fusion clip, and then click the Fusion page button,
or press Shift-5. Re-arrange the nodes so that Medialn2 appears above Merge1.

Medialn2

Medialni
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NOTE This lesson uses dual viewers. If your workspace is using a single viewer,
click the Dual Viewer button in the upper-right corner of the viewer.

The two layers are brought into the Node Editor and combined via a Merge node. The
Medialn1 node represents the sky clip from video track 1, and the foreground clip from
video track 2 is represented as the Medialn2 node.

Hover your mouse pointer over viewer 2 and drag the middle mouse down and to the
left until you can see the resolution in the top-right corner of the frame.

When using a Fusion clip, the resolutions of the nested clips are set to timeline
resolution. This is the working resolution of the composite.

With your mouse still over viewer 2, press Command-F (macOS) or Ctrl-F (Windows)
to fit the image to the viewer once more. Select the Medialn1 node, and then click the
Transform tool in the toolbar.

Press 1 to see the Transform node in viewer 1.

Retaining a Clip’s Resolution
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The Transform node is added to the sky clip. Since this is a large-resolution image in a
1920 x 1080 frame, we should be able to scale it back a considerable amount and see
the remaining image that falls outside the frame boundary.

11 Select the Transform node and, in the Inspector, drag the Size slider down just a
small amount.

As you scale back the image, it reveals transparency around the edges as if the
background clip has a resolution of 1920 x 1080. The beauty of a Fusion clip is that it allows
you to use the intuitive tools of the edit page to layer, trim, and align your clips before
bringing them into the Fusion page. However, the new Fusion clip is created at the timeline
resolution. If your source clips and timelines have the same resolution, as you had in
Lesson 2, then the Fusion clip is the most efficient way to set up your composite. However,
if you are dealing with clips larger than the timeline resolution, then a Fusion clip will resize
all the sources to fit. This is not the best setup for dealing with a large photo of the sky
where we only want to use a small area. Let's look at a different technique that will allow

us to work with clips at mixed resolutions.
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Controlling a Composition’s
Resolution

Unlike a Fusion clip, bringing a single clip from the edit page to the Fusion page maintains
the clip's original resolution, despite how the timeline resolution is set. This means you're
always using the highest-quality compositing in the Fusion page when dealing with a single
layer from the edit page.

Return to the edit page and choose Edit > Undo to undo the Fusion clip in the timeline.

b € SKYWITH RAINBOW.tif

With the clips returned to individual layers in the edit page, we can disable video track
2 and bring the sky image into the Fusion page.

Select the foreground clip on video track 2 and press D to disable the clip.

Foreground

b €2 SKYWITH RAINBOW.tif

Select the Sky image on video track 2 and reset the scale you applied in the Inspector.

Switch to the Fusion page.

If a clip or track is disabled, clicking the Fusion page button takes the first enabled clip
under the playhead. In this case, it switches to the Fusion page with only the sky image
from video track 1.

Controlling a Composition’s Resolution
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The resolution seen above the frame is now defined by the original source image
resolution (3888 x 2187). Now you're compositing with the highest-quality sky image,
but you still need to bring in the foreground clip.

Open the media pool, and from the “Sky replace” bin, click on the metadata badge in
the lower-right corner of the foreground clip.

-

Foreground

Blackmagic URSA 1_1_2016-03-03_0739_C...
01:00:00:00 01:00:06:18 00:00:06:18

1920x1080

24,000

Square

Apple ProRes 422 HQ

Sat Oct 26 11:27:53 2019
None

The metadata badge reveals a pop-up with some basic metadata about the clip. One
of the pieces of the metadata is the resolution, which is 1920 x 1080. Dragging this clip
from the media pool into the Node Editor retains the clip’s native resolution.

Drag the foreground clip to an empty place in the Node Editor, and then press 1 to see
itinviewer 1.

Above the frame, the clip displays its resolution as 1920 x 1080.

Just like single elements brought in from the edit page, elements from the media pool
always retain their original resolution.

To keep the media organized, let's rename the nodes so that the names are more
descriptive.

Rename the Medialn1 node to SKY and the Medialn2 node to ACTORS.

With all the media at its highest resolution and our nodes named appropriately, we can
begin creating the sky replacement.
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2 Drag the output of the ACTORS node onto the output of the SKY node to automatically
create a Merge node.

Viewer 2 now shows a composition that uses the resolution of the larger sky image
with a small 1920 x 1080 HD foreground in the middle.

A fundamental concept in Fusion is that the background input of a Merge node
determines the resolution of the Merge node’s output. This is how you can control the
resolution when mixing footage of different sizes. In our case, the background input
is the large sky image, not the full HD resolution of the foreground clip and timeline.
To correct the resolution of our composite, we need to change the resolution of the
sky image to be 1920 x 1080. There are a couple of ways to control the resolution of a
composite, but we will use a Background tool.

TIP The Resize and Crop nodes also modify the resolution of a clip.

Drag the Background tool (the first tool at the far left of the toolbar) from the toolbar
to an empty place in the Node Editor.

Controlling a Composition’s Resolution
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In the Inspector, click the Image tab.

Background1

v Image

The Background tool's Image tab in the Inspector includes controls for the background
image resolution.

Click the Auto Resolution button to disable the automatic resolution setting and enter
1920 as the width value and 1080 as the height.

The background input of the Merge tool determines the resolution of the Merge tool's
output. So, by connecting a 1920 x 1080 HD image to the Merge's background input,
we can set the composite’s resolution. The easiest technique to accomplish this is to
use a Background node.

Select the Background node, and from the toolbar, click to add a Merge node.

Select the Merge node and press 1 to see the black solid color of the Background node
in the viewer, then hover your mouse pointer over viewer 2, hold the Command key
(macOS) or the Ctrl key (Windows), and scroll the middle mouse until you can see the
resolution in the top-right corner of the frame.

The Merge node now uses a resolution of 1920 x 1080. If we connect the larger Sky
node to the foreground, it will be cropped (not resized) by the Merge's resolution.

Replacing a Sky



Click the connection line near the input of Merge1 to disconnect the Sky node.

Mergel

A

Drag the output of the Sky node to the green foreground input of the Merge2 node.

As soon as the connection is made, viewer 1 shows the Medialn1 node at its full
resolution but cropped by the 1920 x 1080 Merge node.

Drag the output of the Merge2 to the background input of the Merge1 node.

»  Backgroundl m Merge

The Merge loaded in viewer 2 shows exactly what we had on the edit page. One layer
lies over another without any transparency. That's because the Merge places the

SKY foreground over the background, and since there is no mask or alpha channel

in the foreground, there is no transparency.

Compositing Using the
Darken Apply Mode

Compositing typically requires an alpha channel or matte, as we used in Lesson 1 with

the HUD. Mattes or alpha channels are used to tell the software which areas of the
foreground it needs to cut away to reveal the background. In our case, we have two
elements, the live-action scene of the actors and our sky picture, neither of which have an
alpha channel. When starting a sky replacement, some people might be inclined to reach
for a Luma Keyer immediately. A Luma Keyer is a tool that creates a matte based on the
luminance in an image, like an overexposed sky. However, it is usually not the right tool for
sky replacement. At least it's not the right tool to handle the edges of a sky replacement.

A much better choice is to start with an Apply mode located in the merge you already have.

Compositing Using the Darken Apply Mode
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Select Mergel and, in the Inspector, set the Apply mode to darken (sometimes
called minimum).

The Darken Apply mode shows the darkest pixel wherever the foreground and
background overlap. Since the sky image is darker than the overexposed sky in the
actors’ clip, most of the sunset sky displays. However, there are lots of issues we
need to deal with before getting a good-looking sky replacement.

The Channel Booleans node also contains a minimum mode and can be
used in place of a merge.

Select the Sky in the Node Editor and, in the toolbar, click the Transform node.

The larger sky image is cropped (not resized). You still have access to the entire sky
image. You are just looking at it through a 1920 x 1080 window. The Transform node
will allow you to reposition the larger sky frame within the crop window.

Replacing a Sky



In viewer 1, drag the center onscreen control to the left edge of the frame to include
more interesting cloud formations.

Adding Effects from
the Effects Library

Up until now, we've added nodes using either the Select Tool dialog (summoned using
the Shift-Spacebar command) or the toolbar. These are great when you know what you're
looking for, but what if you simply want to browse a list of all available effects? That's what
the Effects Library is for.

Although switching to Darken mode in the previous section took care of the edges, we'll
still make use of a Luma Keyer to handle the transparency we see over the actors and
hillside. Since the actors’ clip has no alpha channel built into it, a Luma Keyer can create
one for us.

In the upper left of the Fusion page, click the Effects Library button.

The library is organized by category. The Tools category contains all the effects
available only in Fusion.

In the Effects Library, click the Tools disclosure arrow.

Click on the Matte subcategory.

Adding Effects from the Effects Library 79
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From the list of Matte nodes, drag the Luma Keyer to an empty area of the Node Editor,
near the ACTORS node.

¥
> LumaKeyer1

&

Mergel

Drag a second output from the ACTORS node and connect it to the yellow input of the
Luma Keyer.

¥ b4
e Lumakeyer1
s

Nodes can have multiple outputs without causing any reduction in quality.

Press 1 to see the luma key in viewer 1.

Right away, we can see a semitransparent checkerboard pattern that represents

transparency from the Luma Keyer settings. Because you will create a matte, it can

Replacing a Sky



be helpful to view the alpha channel in the viewer instead of the RGB image that is
currently visible.

An alpha channel is a fourth channel that accompanies the red, green, and
blue channels of an image. Alpha channels determine which parts of an image
are opaque and which parts are transparent.

In viewer 1's toolbar, click the Color controls button and select the alpha channel (or
click in the viewer and press the A key).

LumaKeyer1

The viewer displays a grayscale image that represents the transparency based on the
luma key. Areas that are pure white will be transparent, and areas of pure black will be
opaque. Areas of semitransparency will be some shade of gray.

In the Inspector, drag the High threshold slider to the left until the majority of the sky
appears solid white. The High threshold should end up around 0.8.

LumaKeyer1

&4

Controls

Channel  Luminance

An important thing to understand about mattes is that they need to contain pure
black and pure white. Gray areas, as mentioned above, will be a semitransparent mix
of foreground and background. That's OK for glass objects, but most of the time, areas
will be either all foreground or all background. Right now, the sky is completely white,
but the foreground of the actors isn't pure black.

Adding Effects from the Effects Library
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Drag the Low threshold slider slightly to the right to darken as much of the actors and rock
as you can without darkening the sky. The Low threshold should end up around 0.75.

To smooth the harsh edges, drag the Blur slider to about 0.5.

We now have areas of mostly pure black and pure white. Unfortunately for us, there are
many highlights on the actors and some darker areas in the upper left of the sky that will
cause problems in our matte.

The remaining problems we have are the areas where white still shows through due to the
very bright highlights over the actors, the rocks, and the water. There is also a problem in
the upper-left area of the sky. Let's tackle the rocks and actors first. Instead of laboriously
drawing a matte or painting out the holes, we will use an easier method. Enter the Erode
Dilate node. An Erode Dilate node expands or shrinks the edges of a matte.

In the Node Editor, select the Luma Keyer, and from the filter category in the Effects
Library, click the Erode Dilate node to add it to the Node Editor.

«
n

ErodeDilatel L

Mergel
A




Press 1 to see it in the viewer.

In the Inspector, in the Amount slider, type -0.005.

Moving the amount slider left (negative) expands the edge of the matte covering up
the holes. Unfortunately, it also expands the border of the rocks. How do we fix that?
We'll add another Erode Dilate node and set the amount in the opposite direction.

In the Effects Library, click the Erode Dilate node to add a second node directly after
the first Erode Dilate.

ErodeDilatel

[
A4
ErodeDilate2

Mergel
&~

Press 1 to view the second Erode Dilate in the viewer.

In the Inspector, in the Amount slider, type 0.008.

If a slider in the Inspector does not reach the value you want, you can often
type in the number to extend the slider’s range.

The Erode Dilate has brought us closer to having a clean black-and-white matte, but visual
effects are often a game of whack-a-mole, where you fix two problems and reveal another.
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The Erode Dilate has not removed a few white spots on the actors that we will have to fix.
We also need to combine this newly generated matte with the actual RGB image of the
actors to get an idea of our finished shot.

Embedding Alpha into an Image

The matte you created with the Luma Keyer must now be combined with the RGB image
of our actors. When combining mattes with RGB images, one of the most useful nodes
is a Matte Control node. One of its primary functions is to take the alpha channel from
the image connected to foreground input and copy it into the image connected to the
background input.

From the toolbar, drag the Matte Control tool to the Node Editor near the Erode
Dilate 2 node.

v v
Lumakeyer1

ErodeDilate2

v v
MatteControl1

A

Drag a third output from the ACTORS node to the yellow background of the
Matte Control.

The background input on a Matte Control is used to connect the image that will have
the alpha embedded.

Press 1 to view the Matte Control in the viewer and set viewer 1 to view the RGB
channels instead of the alpha channel, either by clicking the Color controls button and
selecting Color or by clicking in the viewer and typing C.
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Drag the Erode Dilate 2 node output to the green foreground input of the
matte control.

A v
LumaKeyer1
L
v
ErodeDilatel

L}
v

ErodeDilate2

/

b4 ¥
MatteControll

A Y

Mergel
4

To embed the alpha channel into the ACTORS image, in the Inspector, set the Combine
menu to Combine Alpha and enable Post Multiply Image at the bottom of the
Inspector properties.

MatteControl1

(2]

Combine Alpha
Copy

Fast Gaussian

Low

Invert Matte

vy k Post Multiply Image

By choosing Combine Alpha, we're telling Fusion to copy the alpha channel from our
Luma Key (entering the node on the foreground input) into the alpha channel of our
ACTORS image (coming in on the background input).
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OK, but why did we check the Post Multiply Image option? We'll get into the full
explanation in Lesson 4, but for now you should understand that there are two types of
alpha channels. Premultiplied alpha channels are typically created by computer graphics
in combination with the RGB image. Straight alpha channels are commonly created by
image processing apart from any RGB image, as we have done here with the Luma Key.
The Merge node in Fusion always assumes the incoming foreground image with alpha is
premultiplied. Since ours isn't yet, we need to perform the premultiplication.

If you're wondering why the checkbox is called Post Multiply, it's simply
because it's happening after (post) the alpha channel has been added to the
main RGB image. The result is a premultiplied image. Confusing, but we'll cover
the whole concept in much more detail in Lesson 4.

You now have the actors with an embedded alpha channel, but if you look in the
viewer, all you'll see is the washed-out sky we're trying to replace. Typically, in a matte,
the white areas are opaque, and black areas are transparent. That is the opposite of
what we have. So, we'll invert the matte.

In the Matte Control’s Inspector, click the Invert Matte checkbox (just above the Post

Multiply Image checkbox).

Before going any further, it helps to view the composite of the foreground with the
sky. The Matte Control output forms our new foreground with alpha, while the output
of Mergel contains the nice clean edges for our composite. Now you'll merge the

two together.

Select the Mergel node and click the Merge tool in the toolbar to add a third Merge.
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Drag the output of Matte Control to the green foreground input on the Merge3 node.

Select the Matte Control node.

At the bottom of the Inspector, click the Post Multiply Image button.

Click the Play button to review the composite.

The results are displayed in viewer 2. The image appears a lot closer to what we want, but
the sky appears very flat and fake, so fixing that will be your next task.

Tracking the Sky into Position

As you play the composite, it looks fine when the image is still, but as soon as it plays and
the camera moves, the illusion falls apart. For this sky replacement to work, the sky needs
to move as the camera moves. Instead of using the Tracker node as you did in the previous
lesson, you'll apply the Tracker as a modifier.

Select the Merge2 node that is connected to the Sky node in the Node Editor.

Transform1
|

!

Backgroundl m Merge2

Tracking the Sky into Position
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You'll need to apply the Tracker modifier to a node that contains position controls.
The Merge tool includes center X and Y controls that can be used to reposition the
clip connected to the foreground input.

In the viewer, right-click over the Merge's center onscreen control, and from the menu
choose Merge 2: Center > Modify With > Tracker position.

Merge2: Center

Modify With

Tracker position N
iy

Alternatively, you can right-click over the center control in the Inspector to
attach the Tracker.

The Tracker modifier is attached to the Merge’s center X and Y controls. Although the
process of tracking is the same as the Tracker node, the Tracker modifier is a single-
point tracker that tracks up and down and side to side movement, so it is more limited
than the multipoint tracker you used in the split screen. Still, it is perfect for quick,
simple tracks, as we have here.

Replacing a Sky



Adding a Tracker modifier displays the tracker pattern and search rectangles over the
center position in the viewer. Since it is a modifier, the tracker controls are displayed in
the Merge2's Modifiers tab.

At the top of the Inspector, click the Modifiers tab to display the tracker controls.

Inspector

Track1

The Tracker modifier assumes that you want to track the background of the Merge
node. In our case, we want to track the ACTORS node.

From the Node Editor, drag the ACTORS node to the Tracker source field at the top of
the Inspector.

Inspector

Track1

Tracker

Tracker source

NOTE Asyou drag a node from the Node Editor into an Inspector source field,
the node will appear to move at first, but it'll snap back into its original location
once the mouse pointer leaves the Node Editor.

Move the playhead to the start of the render range.

Just as you did in the previous lesson, you need to position the Tracker over a high-
contrast pattern that moves precisely how you want the sky to move. For this shot, the
ridge in the background has a few rocks that stick out. These would make good high-
contrast tracking points that we can use for the Tracker.

Tracking the Sky into Position
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In viewer 1, drag the handle in the upper-left corner of the pattern box to position
the Tracker over the very small, sharp rock sticking up from the ridge, between the

two actors.

Unlike when viewing the Tracker node, the pattern box does not expand to show a
magnified view of the area you are over. However, the Inspector does contain a small
preview of the selected area.

Since this camera does not move very fast, we can leave the search rectangle at its
default size.

In the Inspector, click the Track Forward button to begin the tracking process.
Track1

Tracker

ACTORS

Viewer 1 displays the progress of the track until the analysis is interrupted around frame
90 when the actor’s head obscures the rock. You'll need to find a way to continue the
tracking for the remainder of this clip. Although the rock you initially selected is fine for the
first half of the clip, it won't be the solution for the second half.

If the tracker is interrupted prior to frame 90, try repositioning the pattern box
or making the pattern box slightly smaller and track the clip again.

Replacing a Sky



Fixing Interrupted Trackers

When the tracking process is completed, a dialog appears to display information about the
number of frames tracked and the time it took.

In the dialog, click OK to continue with the composite.

You now have a solid track for the first 90 frames or so, but you'll need another
solution for the remaining 70 frames. Instead of giving up hope, you can keep the
tracking data of the initial rock you selected for the first half of the shot and now
identify a new tracking point for the remainder of the shot.

In the render range, drag the playhead to frame 90.

This is the last good frame of tracking data from the first rock you tracked. At this
point, you need to locate a new high-contrast object to track.

If the Track1 section of the Modifiers tab has closed, double-click the label Track1 to
re-open it.

In the Inspector, set the Path Center menu to Track Center (Append).

None

Pattern Center

Track Center (Append)

Fixing Interrupted Trackers



92

The Track Center (Append) setting allows you to move the pattern box over a new
object and continue the tracking based on this new point.

In viewer 1, drag Tracker2's handle in the upper-left corner of the pattern box to place
the tracker over the sharp rocks on the right side of the actress.

Click the Track Forward from Current Time button to pick up the tracking process
from frame 90.

ACTORS

C—»—)

When tracking is completed, click Done in the dialog to continue.

Fusion automatically blends the two analyses for Tracker1 to create one seamless motion
path. You now have a steady track that follows the position of the camera movement. Since
you applied the tracker as a modifier to the Merge center X and Y, the motion of the sky
automatically follows the tracker.

If you notice black at the edge of the frame, it may be that the tracking data is
pulling in black from outside the sky image’s frame. To fix this, simply readjust the
sky positioning using Transform1.

Replacing a Sky



Blending In the Original Sky

If you leave the sky replacement as it appears now, it just looks like a pasted-on sky. By
color-correcting the SKY clip, we can adjust how it blends with the original sky, creating a
more natural composite.

Select the SKY clip and add a Color Corrector node using the Select Tool dialog
(Shift-Spacebar).

Adjust the Gain up to blend back some of the original sky. A value of around 1.6 should
work. You can also play with the Gamma to adjust the contrast of the clouds if you like.

Channel RGB

Gamma

irightness

Some sky replacements require a few mattes, and some require none. Some might require
a bit of color correction to get the foreground and background to match better. The goal of
this lesson was to give you a basic structure you can build on for any sky replacement you
may come across.

»  Backgroundl ~ » Mergel —_— Merge3 —_— » MediaOutl [ ]

i

Completed node tree for Lesson 3.

Blending In the Original Sky
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Practice Exercise

To reinforce the concepts you learn, there will occasionally be optional exercises at the
end of the lessons. These exercises will be very similar to the procedures you will have
just completed.

However, they will have brief directions for guidance instead of detailed
step-by-step instructions.

In this practice exercise, you'll need to use the masking and tracking skills you've learned
from these past two lessons. Using the third edit in the timeline, you'll simulate depth of
field by creating a matte around the robot in the front, tracking the matte, blurring the
remaining robots, and adding a separate stronger blur to the background.

From the edit page timeline, go to the third edit in the timeline (first blue marker) and
switch to the Fusion page.

Bring both layers into the Fusion page.
Create a polygon matte for the frontmost robot on the left.
Track the robot and apply the tracking data to the polygon matte.

Add a Blur to the Robots node and use the matte so the blur applies only to the robots
in the back.

Add a Blur to the background room, so it is blurred more than the robots to simulate
greater depth of field.

Color correct the robots to be slightly darker and have less saturation.

Here's a final image of how your composite should look.

Replacing a Sky



Lesson Review

True or false? Clips from the media pool use the timeline resolution when added to the
Fusion Node Editor.

True or false? The Merge node contains Apply modes such as screen, multiply,
and darken.

True or false? To offset a tracking point when a pattern becomes obscured, you must
create a new tracking point.

True or false? Tracker modifiers have all the same controls and functionality as the
Tracker node.

True or False? A Luma Keyer is used to create a mask from the brightness in an image.

Lesson Review

95



96

False. Adding a clip from the media pool to the Node Editor uses the clip's native
resolution.

True. The Merge node contains Apply modes such as screen, multiply, and darken.

False. To offset a tracking point, you must set the Path Center menu to Track
Center (Append).

False. Tracker modifiers track only a single tracking pattern, while a Tracker node
can track multiple patterns.

True. A Luma Keyer is used to create a mask from the brightness in an image.

Replacing a Sky



Lesson 4

Replacing

Signs and Screens

You've learned how to match move
using the standard Tracker; now it's
time to learn a more sophisticated
method that is ideal for replacing tablet
screens, billboards, or signage on the
side of vehicles. This type of match
move is most efficiently done using a
Planar Tracker. Planar tracking, as the
name suggests, relies on there being a
flat, planar surface for it to work.

Time

This lesson takes approximately
40 minutes to complete.
Goals

Tracking Planar Surfaces
Painting with the Clone Tool
Using Photoshop PSD Layers
Corner Pinning an Image
Combining Mattes and Images

Match Moving with the Planar
Transform

Finalizing the Composite
Practice Exercise

Lesson Review
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In this lesson, you'll add a new sign to the side of a moving van. The process of adding a
new sign to a moving vehicle (or screen to a tablet) is made up of three parts. First, you'll
need to track the flat surface as it moves. Then, using Fusion’s Paint tool, you'll remove any

tracking markers to create a clean surface. Once that is complete, you can composite a new
logo using the tracking data.

Completed composite for Lesson 4.

Tracking Planar Surfaces

Having Fusion built in to DaVinci Resolve comes with a number of benefits. One of those
benefits is that it changes visual effects and motion graphics from a shot-based, isolated
part of the workflow to an integrated, multi-shot workflow, enabling you to change shots
in an instant without importing, exporting, or timing the clips to the few frames you need.

Open DaVinci Resolve 18 and, from the Project Manager, open the
project into the edit page.

In the Timelines bin, double-click the timeline.

Move the playhead over the fourth edit and the third red marker, and press Shift-5 to
switch to the Fusion page.

+3 VanTrack.mov
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Press the Spacebar to view the clip.

This shot of the van will ultimately need a sign added as it drives off. However, the first
part of the composite is to put those black markers to use and track the side of the van.

The single-point tracker is the simplest tracker in the Fusion page. Although it works
well on many shots, it's not the most optimal tracker in some specific cases. For
instance, what happens if the camera changes perspective? No matter how many point
trackers you use, they are still independent 2D points that can only process limited
camera motion. A Planar Tracker tracks multiple points across a defined flat surface,
such as a billboard, TV screen, or in this case, the side of a van. In doing so, it calculates
a more accurate 2.5D track that can contain more complex motion.

On this shot, you'll track the van’s movement, so when you ultimately add the new
logo, it will move across the shot as the van moves.

In the upper left of the user interface toolbar, click the Effects Library button to reopen
the panel.

Select the Tools > Tracking category and insert the Planar Tracker tool between the
Medialn1 and the MediaOut1 nodes.

v
» PlanarTracker1 ¢ g——00mm--—->-—->p MediaOut1

Press 1 to see the Planar Tracker in the viewer.

It's important to start planar tracking on a frame where the area you are tracking is
clear and large in the frame. In this case, frame 65 is ideal because the side of the van
is large in the frame but moving slowly, effectively eliminating motion blur.

Tracking Planar Surfaces 929
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Move to frame 65 in the comp.

Unlike the tracker that you used in the previous exercise, the Planar Tracker does
not use one or two tracking patterns. Instead, it tracks the motion, scaling, and
perspective distortions of an entire planar surface in a background clip. So, the next
step is to identify the planar surface you want to track.

When the Planar Tracker is added, the polygon shape toolbar appears above the viewer.
The same functionality you used previously to create polygon shapes applies here.

If a clip has any significant lens distortion, it should be removed using a Lens
Distort node before performing a planar track.

Selecting a Good Area for Planar Tracking

When drawing a shape around the area for planar tracking, keep the following
guidelines in mind:

— Select as large an area as possible.
— Select an area that stays in frame as much as possible.
— Select an area that is clear of obstruction from moving foreground objects.

— Start your track when the area you are tracking is at its maximum size. You
want as much detail in the area as possible when you begin the track.

— Make sure everything included in the selection is part of the same rigid body.
That is, make sure you don't include any area with independent motion, such
as, in this example, the background behind the van or even the rotating tires.

— Start your track on a frame in which the area is the least distorted.

Replacing Signs and Screens



In viewer 1, draw a very simple shape that fits around the side of the van. Do not go
outside the van, and do not include the wheels.

The area inside your shape is the pattern that will be tracked over time.

When defining the area to track, include only pixels inside the shape that
belong to the plane being tracked (in this case, the side of the van). Do not
include any of the background area.

At the top of the Inspector, click the Set button.

PlanarTracker1

The current frame is set as the reference frame for the rest of the track.

If you stop before the tracking is completed, you must re-click the Set
button before resuming the tracking process.

Tracking Planar Surfaces
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At the bottom of the Inspector, click the Track to Start button.

» Pattern

Tracker Point

Motion Type  Perspective

Background

Luma

The viewer shows the tracking as it progresses backward to the start of the shot.
When it is done, a series of dots appears in the render range to indicate that the
track is completed.

When the first half of the track is done, return to the Inspector and click the Go button
to move the playhead back to frame 65. Then click the Track to End button.

Despite the majority of the van disappearing offscreen, the Planar Tracker continues to
track right to the end of the clip.

To test the track, in the Inspector, change the Operation Mode pop-up menu to Steady
and play the clip. (Make sure you have the Planar Tracker node and not the Media In
node displayed in a viewer).

The side of the van should stay locked in place throughout the timeline playback.

Reset the Operation Mode pop-up menu to Track.

The Steady setting is obviously not what you're trying to accomplish for the shot, but it's a
good way to evaluate a track and ensure that there’s no drift or bumps in the tracking data.
If you do see errors, readjust your tracking shape at frame 65 and try again.

Painting with the Clone Tool

With the tracking done, we can now focus on removing the tracking markers. You will
create a clean side of the van using the Paint tool to clone white areas of the van over
each marker. You just need to freeze a single frame to paint over, then cut out the clean
side of the van and composite it over the live full-motion shot. Let's start by freezing the
frame we want to paint over.
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In the Effects Library, navigate to the Tools > Miscellaneous category, and drag the
Time Stretcher tool into an empty part of the Node Editor.

p TimeStretcher! 4+ m

The first part of this job is to freeze the van on a clear frame. Freeze frames from the
edit page do not transfer into the Fusion page, but it is easy enough to create a freeze
frame using Fusion’s Time Stretcher node.

Drag from the Medialn1 output to the yellow input on the TimeStretcher1 node.

» TimeStretcher! € m

Dragging a second output from the Media In node is similar to duplicating a clip in
a timeline.

Press 1 to load the Time Stretcher node into the viewer.

The Time Stretcher automatically adds a keyframe when you connect a source to it.
Doing so makes it easy to speed ramp a clip. However, you want to create a freeze
frame, so you'll remove this keyframe and enter the frame number you want to hold
for the entire shot.

In the Inspector, click the red Keyframe button to the right of the Source Time slider to
disable it.

TimeStretcher?

G

&
Controls

Source Time

Blend

Painting with the Clone Tool
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The keyframe button turns white, indicating that animation has been removed from
the Source Time channel.

The frame you want to hold for the duration of the clip is frame 65, because it displays
a clear, undistorted image of the side of the van.

The Time Stretcher frame numbers are based on the entire clip length, not
the duration of the clip in the timeline.

In the Source Time field, enter 65 to hold frame 65 for the entire length of the shot.

If you do not keyframe this value, the Time Stretcher will hold the frame throughout
the clip’s duration. That's all it takes to create a freeze frame.

Now, you'll paint out the markers on this freeze frame.

In the Node Editor, select the Time Stretcher. In the toolbar, click the Paint tool to
connect it after the Time Stretcher.

< m

v v
» PlanarTrackerl 4 m

s

Press 1 to see the Paint tool in the viewer.

With the Paint tool selected, the Inspector changes to show various paint controls, and
a viewer toolbar is displayed above the viewer with the various paint stroke types.

The Paint tool offers several stroke and paint styles suitable for motion graphics or
retouching shots. In this exercise, you'll use a simple stroke brush in Clone mode to
copy white areas of the van and paint over the markers.

In the viewer toolbar, click the Stroke tool.

The Stroke tool is the most versatile of paint tools and the one you will use for most
paint tasks.
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In the Inspector, click the Clone Apply Mode button to switch from painting with color
to painting with a clone brush.

v Apply Controls

Apply Mode ,fy
s

The clone brush works by selecting a source area from a frame and a destination
area. The source area is the area in the frame you want to duplicate as you paint. The
destination area is the area you will paint over using the content of the source area.

Option-click (macOS) or Alt-click (Windows) to the left of the first black marker in the
upper left of the van to select the source area offset for the clone brush.

—
OF x
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Once you've selected the source area offset for the clone brush, paint over the
first marker.

As you paint, the source area offsets by the same amount. For instance, when you
paint upward, the source area selection also moves up. It is often good to keep the
source selection near the area you will paint over, because doing so keeps the texture
and color of the two areas as similar as possible.

You can hold down the middle mouse button and drag in the
viewer to pan.

If necessary, Option-click (macOS) or Alt-click (Windows) on a new offset for the next
marker and paint over it. Command-drag (macQOS) or Ctrl-drag (Windows) to resize
the brush. Continue choosing a new offset and painting over each marker until all the
markers are removed.

Painting with the Clone Tool
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You now have a clean van, perfect for compositing a new logo. In the next exercise,
you'llimport a logo and learn how to blend it onto the side of the van.

Using Photoshop PSD Layers

DaVinci Resolve can use various still-image formats for graphics, including TIFF, JPEG, and
PNG. It can also use layered Photoshop files, allowing you some flexibility when it comes to
selecting the layer you want to use from the PSD graphic.

Ensure that nothing is selected in the Node Editor by clicking in an empty graph area.
You'll add a graphic file to this graphics bin.

From the Fusion menu, choose Import > PSD. Then, navigate to the R18 Fusion
Lessons folder > Fusion Files and import the file.

Fusion

Import
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Once imported into the Node Editor, you will get a node representing each layer in the
file and a merge node, labeled Normal, that combines the layers together.

v
Normal

With the Normal node selected, press 1 to see it in the viewer.

This photoshop image is 1920 x 1080 resolution and includes two layers. One layer is
the main logo, while the other layer is the address of the company. You can delete the
Normal and ADDRESS nodes to use only the LOGO layer.

Select both the ADDRESS and Normal nodes and press Delete or Backspace on
your keyboard.

With only the LOGO node remaining, you can composite it over the van.

Using Photoshop PSD Layers
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Connect the output of the LOGO node to the output of the Paint1 node to create a
Merge node.

v

TimeStretcher] m—# Paintl ¢ n—» Merge1

; v v
Medialni L PlanarTracker] € m

=T

Connect the output of the LOGO node to the green input of the Merge node.

That looks just like what it is: a photoshop document placed on top of the van clip.
However, with some blending, color correction, and positioning, you can make it
appear much more realistic.

Select the Merge node and, in the Inspector, set the Apply Mode to Soft Light.

The soft light apply mode is a good choice because it softly lightens the logo based
on the white van color, giving the logo a nice, diffused look, However, since the crease
lines in the van are darker than much of the logo, the logo is darkened in those areas.
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The result is good but maybe a bit too light and diffused. We can improve it a bit using
some simple color correction.

From the toolbar, insert a Brightness Contrast node between the LOGO node and the
Mergel node.

Adjust the Lift down to darken the black part of the logo and increase the Contrast
slider until the logo appears less diffused.
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Although looking much better, the edges of the graphic have become a bit ragged.

This is a common problem that occurs when you perform color correction on an image
with a premultiplied alpha channel. To correct this problem, you can enable the Pre-
Divide/Post-Multiply checkbox in the color corrector.

To correct this, we must pre-divide before the color correction and post-multiply after
it. We can do both with just one checkbox in the Brightness Contrast node.

With the Brightness Contrast node selected, click the Pre-Divide/Post-
Multiply checkbox.

Forward

You now have a great-looking logo that just needs a bit of positioning to appear like it is
actually painted on the side of the van.
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About Straight and Premultiplied Alpha Channels

To display anti-aliased edges in an alpha channel, Fusion performs a multiplication
operation on the edge pixels. At that time, some of the original color values shift
slightly darker to achieve the anti-aliased look.

Straight alpha channel Premultiplied alpha channel

In Fusion, this color shifting is not noticeable because the Merge tool expects to
receive a premultiplied alpha channel. It becomes noticeable only when the black
level or gamma of the graphic changes through some tonal value adjustment such
as color correction. The result is either a brighter or darker outline around the
edges of the graphic.

Composited premultiplied Adjustment on premultiplied
alpha channel alpha channel

Luckily, you have a relatively easy solution available. You perform an operation that
divides the multiplied alpha channel, then make your color correction, and finally
remultiply the edges again. Most of the color correction tools in Fusion include a
Pre-Divide/Post-Multiply checkbox that does the work for you. All you have to do is
be aware of the issue and when it might need to be corrected.

Using Photoshop PSD Layers
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Corner Pinning an Image

Positioning this logo could be done using a Transform node, but that wouldn't allow
you to replicate the perspective distortion from the camera’s viewpoint. To recreate any
perspective distortion, it is best to position this graphic using a Corner Positioner node.

In the Node Editor, select the Brightness Contrast node.

You'll place the Corner Positioner node directly after the Brightness Contrast node but
before the logo is merged with the freeze frame.

In the Effects Library, select Tools > Warp, and then click on the Corner Positioner tool
to add it to the Node Editor.

Mergel

. A

The entire logo has been squeezed onto a tiny area of the van based on the corners

of the frame. To fix that, you need to position each corner of the logo near the
corresponding corner of the frame. You can do this easily by dragging each corner into
position or entering values in each of the four corner position controls in the Inspector.

In the viewer, drag the upper-right corner of the graphic corner pin outline to the
upper-right corner of the frame, or enter 1 for Xand 1 for Y in the corresponding
Inspector fields.

Drag the lower-right corner of the graphic corner pin outline to the lower-right corner
of the frame or enter 1 for X and 0 for Y in the corresponding Inspector fields.

The two corners on the left will frame the graphic best if they are located about 25% in
from the left edge.

In the Inspector, set the top left X value to .25 and the Y value to 1, placing the corner
at the top of the frame and 25% in from the left edge.

v Top Left

Top Left X
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In the Inspector, set the bottom left X value to .25 and the Y value to 0, placing the
bottom at the bottom of the frame and 25% in from the left edge.

With these values entered, the graphic is placed over the van but positioned a bit too

close to the roof. Fine-tuning the left corners to be lower in the frame will pull the
graphic away from the top of the van.

In the viewer, drag the top-left and bottom-left corner pin control points slightly down
in the frame until the graphic is more realistically located on the van.

—

y
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7

Corner Pinning an Image
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The placement and appearance of the graphic is perfect, but it is still just placed on a still
frame without any movement. Hang in there; you'll fix that in the next exercise.

Fusion Coordinate System

Fusion'’s 2D coordinate system is normalized, which means that it always uses a
value between 0.0 and 1.0, regardless of the image’s resolution. It begins in the
lower-left corner with an X value of 0 and a Y value of 0. The upper-right corner has
an X value of 1.0 and a Y value of 1.0. For any image resolution, the absolute center
is always X=0.5and Y =0.5.

X=0.0 Fusion viewer coordinate system X=1.0
=1.0

-
-

-




Combining Mattes and Images

So far, you have a freeze frame of the entire shot, but you need to isolate the side of the
van with the logo to composite it. This is where the rotoscoping technique you learned
earlier comes in handy. You'll create a matte that isolates just the side of the van.

Go to frame 65, and then, from the toolbar, drag the Polygon tool into an empty area
of the Node Editor near the Merge tool.

»| Polygon1l €

With the Polygon tool selected, draw a shape around the side of the van using
the creases by the door and roof to guide your matte. Be sure to close your matte
by connecting the last and first control points or by pressing Shift-O to connect
them automatically.

You now have a matte, but you have nowhere to connect it into the node tree. All the
available blue Effect Masks inputs are not the type of mask input you need. An effect
mask limits the area of an effect. What you are doing here is combining an image with
a matte, effectively cropping the image. This type of mask is often called a garbage
matte. You need to add a node that can accept a garbage matte input. The most
commonly used node for this purpose is called a Matte Control node.

Combining Mattes and Images
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In the Node Editor, select the Merge1 node, and then in the Effects Library select the
matte category.

Click the Matte Control tool from the Effects Library to add it after the Mergel node.

» Polygoni o m

v v
» MateControll m
F S A

Press 1 to see the Matte Control in the viewer.

The Matte Control is typically used to copy or combine mattes from a foreground to
a background. In this situation, you'll use it to copy a matte to the background freeze
frame. However, because the Matte Control has several possible inputs, you need a
way to ensure that you select the correct one.

Option-drag (macOS) or Alt-drag (Windows) from the Polygon output to the Matte
Control node and release the mouse button.

» Polygoni O P

When you release the mouse button, a pop-up menu appears listing all the possible
inputs of the matte control. This menu makes it easier to select the correct input.

For this task, you want to use a garbage matte.
In the pop-up menu, click the Garbage Matte to connect the Polygon.

The viewer now shows a hole where the side of the van used to be. Your matte is used
to cut out the side of the van rather than isolating it. You can use the Inspector to
reverse this operation.
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With the Polygon node selected, in the Inspector, click the Invert button.

The side of the van with the logo is the only part seen from the freeze frame. You can now
composite this stillimage over the top of the moving image using the Planar Tracker data
to move it in sync with the full-motion shot.

Match Moving with the
Planar Transform

For simple corner-pinning images, you can connect directly into the Planar Tracker.
However, when you're working with irregular polygon matte shapes or anything other
than images of the same aspect and resolution of the composition, the more appropriate
method is to use the Planar Transform.

In the Node Editor, select the Planar Tracker node.

At the bottom of the Inspector, click Create Planar Transform.

Create Planar Transform

Match Moving with the Planar Transform
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A Planar Transform node is created that contains all the transform and perspective
distortion data captured by the Planar Tracker. You can apply this data to any input
image or matte, thereby saving lots of time compared to rotoscoping objects.

Connect the output of the Matte Control to the yellow input of the Planar Transform.

» Polygonl £

¥

» MatteControll —_— kPIanarTransf... P

LA A

Press 1 to view the Planar Transform in the viewer.
Drag through the render range to preview the match-moved side of the van.

The freeze frame of the van's side now follows the driving motion. The next step is a
simple merge to composite the van side over the moving van shot.

Select the Planar Tracker and press Delete.

Once you have the Planar Transform, there is no need to keep the Planar Tracker. All
the data captured from the tracking is now stored in the Planar Transform.

From the toolbar, drag the Merge node over the connection line between the Medialn1
and the MediaOut1 nodes to insert it.

Drag the output from the Planar Transform node to the green foreground input of the
Merge2 node.

Select the Merge2 node and press 1 to see it in the viewer.

Press the Spacebar to play the entire shot.

You now have fairly convincing results. In the next exercise, you'll address a few little
cleanup areas to finish this shot.
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Finalizing the Composite

If you look carefully at later frames (such as frame 90), you'll see a clear shift in the
shadows between the masked region and the moving van.

1

Move the playhead to frame 90.

This is a common problem resulting from the shadows changing in the live shot. Your
freeze frame lighting is baked in and doesn’t update with the moving shot. A simple
blur could disguise the seam. However, because the clean van goes right to the top
of the roof, you'll use the variable soft-edge on the polygon tool only where needed,
toward the base and back of the van.

Move to frame 65.

TIP It's important to always perform changes to a matte on the original frame
where the adjustments were made. Doing so will avoid accidentally adding
keyframes and interpolating between adjustments.

Finalizing the Composite
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Select the Polygon node and, at the top of the viewer, click the Make Double Poly button.

Right-click over one of the control points in the viewer and choose Controls > Select >
Polygon 1: Outer Polygon

Drag the middle control point along the right edge of the shape to create a soft
transition edge.

If you need to move a second control point, first click off into the gray area
of the viewer to deselect the initial control point. Then hold Command (macOS)
or Ctrl (Windows) as you drag the second control point.

Select the MediaOut1 node to hide the onscreen controls for the Polygon node and
play the clip to preview the results.

The matte now looks clean. The final touch to make our logo appear more natural is
to fix the “strobed” motion that the logo appears to have. This is due to the original
camera footage having motion blur as the van gathers speed and our graphic
having none.
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With the Planar Transform node selected, in the Inspector, click the Settings tab.

PlanarTransform1

Enable motion blur.

The default blur seems a little strong for the shot, so you'll dial back the shutter angle.
You'll also increase the quality of the blur to remove any visible stepping.

Adjust the Shutter Angle down to 130.0 and the Quality up to 5.

With that, the shot is complete. The technique you learned here can be used to replace
many different objects in a shot, from simple street signs to touchscreens and even
tattoos. Creating the clean surface with the Time Stretcher, Paint tool, and Polygon Spline
gives you a very simple but powerful recipe for common problems that may arise in a shot.

Completed node tree for Lesson 4.

Finalizing the Composite
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Practice Exercise

This practice exercise is almost identical to the van exercise, although there is no paint
required. The goal is to replace the twitching closed eyes on an actor with a freeze frame of
his eyes, so they remain static throughout the shot.

Go to the next-to-last clip in the timeline.

The man on the gurney moves his eyes too much in this shot. This would be an easy fix
if the camera didn't rotate as it looked down on him. However, whether it be the eyes, a
piece of the set, or a few people, the job of removing patches from a frame or covering
up unwanted areas is a common task that can help save a shot. Fixing this particular
shot is a very quick and easy procedure almost identical to what you have completed
with the van shot.

Planar track the face of the man.

Use the Time Stretcher node to freeze a frame.

Add the Matte Control and a Polygon tool to isolate the eyes.
Create a Planar Transform.

Use the Planar Transform to move the isolated eyes.
Composite the eyes over the moving face.

Soften the edges of the Polygon node.
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Lesson Review

True or false? You must click the Set button before you begin planar tracking.

True or false? When drawing a shape around a surface for planar tracking, you should
include as much of the background as possible.

Which of the following make for good planar tracking surfaces:

Side of a building

Billboard

A bouncing ball

All of the above

None of the above
True or false? The Planar Transform can be used to track planar surfaces and
composite the results.

True or false? When cloning with the Paint tool, you hold the Option (macOS) or Alt
(Windows) key and click to select the clone offset source, and then keep the Option or
Alt key pressed while you paint over the destination.
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True. Clicking Set identifies the reference frame for the planar tracker.

False. When drawing a shape around a surface for planar tracking, you should not
include any of the background.

a) and b) are ideal for planar tracking. c), the bouncing ball, is not a planar surface and
therefore not a good option.

False. The Planar Transform uses the tracking data from a Planar Tracker and applies to
itits inputimage. The Planar Transform has no compositing capabilities.

False. When cloning with the Paint tool, you hold the Option (macOS) or Alt (Windows)
key and click to select the clone offset source, and then release the Option or Alt key
when you begin painting over the destination.
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Lesson 5

Compositing
Green-Screen

Content

Green- or blue-screen keying is the
classic visual effects work that comes
to mind for most people. A foreground
subject is shot against a bright blue or
green screen, which is then keyed to
make it transparent, thereby allowing
the subject to be placed on a new
background.

Time

This lesson takes approximately
60 minutes to complete.
Goals

Managing Color for Visual Effects
Why Use Linear Color Space?
Pulling a Green-Screen Key
Refining a Matte

Rotoscoping Auxiliary Mattes
Lining Up the Background
Color Correcting Elements

Sending a Matte
to the Color Page

Lesson Review

126
130
132
136
140
146
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The keying process is a procedural method of generating a matte, rather than the
manually drawn mattes you used in previous lessons. The process of compositing with
green screen is really an art unto itself, but a simple workflow can be followed for most
keys. The trick is not to try to do everything with a single keying node. Focus the keyer on
the fine detailed edges of your foreground subject, and then you can manage other areas
with other tools. In the end, combining multiple mattes together will always get you better
results quicker.
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Completed composite for Lesson 5.

Managing Color for Visual Effects

Before you begin this keying lesson, we must cover some of the more technical aspects
of compositing. Color management is a critical part of the visual effects workflow, and the
requirements for compositing are slightly different than editing or color grading. You'll
start this keying job by setting up a scene-referred color managed workflow.

NOTE The Timelines bin includes a Backups bin with timelines saved at various
stages of the lesson and a Completed Projects bin with finished compositions.
These bins are both available for reference and reverse- engineering the

node trees.
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Open DaVinci Resolve, and in the Project Manager, open the
project that you have been using for the past three lessons.

From the Timelines bin, double-click the timeline. Then go to the last red
marker, which is over the green screen of our musician.

Click the Fusion page button.

This shot from a Steve Vai music video is typical of a professional green-screen
shoot. The first thing you might notice is that it appears to have low contrast and
low saturation. This is often the case with content acquired on modern digital

film cameras. Digital film cameras apply a very pronounced gamma curve to clips

to achieve a higher dynamic range. To a much lesser extent, every HD video clip,
Photoshop document, or web graphic has a nonlinear gamma value based on either
an sRGB or Rec 709 2.4 color profile.

The problem with using nonlinear gamma curves is that compositing operations
expect images to have linear gamma, not modified gamma values. Why? Because the
math used in almost every compositing operation works more predictably assuming
images have linear gamma.

So, if you simply click the Fusion page and start working on your HD or RAW content,
you're starting out on the wrong foot.

To composite, you first need to remove the nonlinear gamma curve from this green-
screen shot and convert it to linear. Then, you'll reverse the process and ensure that the
output from the Fusion page will apply the correct nonlinear gamma according to your
output format. Sound confusing? Don't worry; DaVinci Resolve handles all of this with
very little effort from you. You just need to enable DaVinci YRGB color management.

Managing Color for Visual Effects
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Choose File > Project Settings, and in the sidebar, click the Color
Management category.

In the Color Science menu, choose DaVinci YRGB Color Managed.

Color Space & Transforms

The metadata embedded in camera-original clips carry information about the clip’s
gamma curve and gamut. The “Output color space” dropdown menu in the settings
defaults to Rec 709 gamma 2.4. That will work for our purpose, but you may change
that in the future based on your final output. The Color Management preset primarily
handles the feel of controls on the color page and how high dynamic range (HDR) clips
are tone mapped for specific outputs. Again, the default for SDR Rec 709 will work for
our green screen.

If you do not have a calibrated HD display connected to your computer
when creating visual effects, it is more common to set the output color space to
SRGB to match your computer display.

Click Save to close the window.
The image in the viewer now appears with more saturation and more contrast.

Turning on Color Management performed a number of processing steps automatically.
It first converted the Media In nodes to linear gamma. The second step it performed
was to enable a LUT (Lookup Table) in the viewer, so you are not looking at the linear
image. Images in linear color space are rather dark and highly saturated and therefore
unpleasant to work with. The viewer LUT makes for a more natural viewing experience,
while still allowing you to composite correctly using linear gamma images.
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In the upper-right corner of the viewer, click the LUT button to disable it, revealing the

linear image.

Aviewer LUT is a simple color adjustment applied to the viewers in the Fusion page.
The image itself is not changed, but only its display in the Fusion viewers. Rather
than showing the image with linear gamma, Resolve enables the viewer LUT to
convert the linear gamma image to the output color space identified in the color
management setting.

In the upper-right corner of the viewer, click the LUT button to re-enable it and thus
view the corrected image.

If you don't use color management, you can add a gamut or Cineon LOG
tool after every Media In node to convert it to linear gamma. Then, add a gamut
or Cineon LOG tool just before the Media Out node to convert back to the final
output gamma setting.

You are now able to composite using images that look correct, but more importantly, will
act correctly during compositing. And when you switch to the edit or color pages, all the
gamma curve corrections are managed automatically, based on the output color space
setting that you configured in the Color Management Project Settings.

Managing Color for Visual Effects
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Why Use Linear Color Space?

The different gamma curves in a post-production workflow, from your camera, the
displays, and even the way the human eye perceives light, are not helping when it comes to
compositing. Why is that? You can blame it all on math.

The majority of compositing tools calculate their effects expecting linear gamma. When
given images with nonlinear gamma, you can get unexpected results. When images are
composited using linear gamma, each step in brightness represents a uniform change

of intensity rather than of a change in your perceived brightness. Let's look at a simple
black to white gradient to help explain this. In the real world (not the one you perceive
with your eyes), light is linear. Think of brightness as being a scale that starts with black at
0 and white topping out at 1.0. Based on this linear tonal range, 0.5 is half the intensity, or
middle gray.

Linear Gamma

LOG Gamma

When you apply a LOG gamma curve, similar to images from a digital film camera, middle
gray is moved and ends up being somewhere around 0.2!

Your middle gray value isn't actually middle gray any longer and no one has told all the
color correction tools about this change! These tools still assume middle gray is based on
linear gamma, and they will operate based on that assumption. Of course, you cannot have
different color correction tools for each and every gamma curve and image format, so the
easiest thing to do is remove all nonlinear gamma curves and work with linear gamma.
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In a more practical example, below we have applied the same color correction on this
split-screen RAW image. We raised the gamma by 25% and boosted green and yellow in
the midtones as well. The lower-left side of the split screen shows the adjustment done
using the original LOG gamma, and on the upper right the adjustment is done with linear
gamma. Both images were then converted back to sRGB with a split wipe for display on the
monitor and print.

Linear Gamma

LOG Gamma

Notice the lack of contrast on the lower-left face. There is also a noticeable midtone color
shift on the log image with a lot more red appearing on the skin and light.

Similar differences happen even with HD content; however, the difference is much less
considering the gamma curve for HD is closer to linear. All of this is due to the fact that
most compositing operations do not handle nonlinear gamma curves. They expect that
lightis linear, so when you add +2 to brightness, the shadows, midtones, and highlights
are increased equally. Color correction is not applied differently to the midtones than to
other regions.

The correct way to composite images is to use a scene-referred color management
system like DaVinci YRGB Color Management or ACES and convert any nonlinear gamma
curve to linear. You can then composite without worrying and allow the scene-referred
color managed system to handle the conversion back to your final output display.

This is how DaVinci Resolve and the Fusion page can work to give you more accurate
compositing results.

Why Use Linear Color Space?
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Pulling a Green-Screen Key

With the color management correctly set up, you can begin the keying process. As you
know, combining shots requires a matte: a grayscale image that identifies parts of the
foreground as transparent and other parts as opaque. Unlike computer-generated images,
this live-action green-screen shot does not include an alpha channel. So, it is up to you to
create the matte through keying. This is often termed “pulling a key.”

NOTE In this lesson, the shot you will work on uses a green screen, but the keying
process works the same for blue-screen content.

In the Node Editor, select the Medialn1 node, and rename it to GREENSCREEN.

In the upper-left corner of the interface, click the Effects Library button. All the tools
for keying are located in the Tools > Matte category.

Click the tools disclosure arrow and select the Matte category. Click the Delta Keyer.

v ¥
» GREENSCREEN m——p DeltaKeyer1 -—
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Because the GREENSCREEN node was selected in the Node Editor, the Delta Keyer is
connected to the GREENSCREEN output. Whenever you are keying, it is helpful to use
two viewers: one where you can see the final output, and the other where you can
view the quality of your matte.

It's worth noting that since the tile picture isn't “aware” of the LUT applied to the
viewer, it simply displays the linear image direct to screen, making the contrast appear
darker than the viewer image we're working with.

If you are not already in a dual viewer setup, from the upper-right corner of the viewer,
click the Single/Dual Viewer button to display two viewers.

] EIEI Inspector

Dual Viewer

Click the Effects Library button to close the panel and open up more room for
the viewers.
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The Delta Keyer is the primary tool used for green-screen and blue-screen keying in
the Fusion page. As powerful as it is, it is also very simple to use.

The term chroma key represents a specific, simplified process of extracting
a matte based on a range of hue and saturation in an image. Modern keyers
like the Delta Keyer use a more sophisticated color difference method to
extract the matte.

Select the Delta Keyer node and press 1 to display its output in viewer 1.

Make sure both viewers have the viewer LUT enabled.

Your first step will be to sample the key color in the foreground image and make it
transparent. Doing so tells the keyer whether it is keying a blue, red, or green screen
and also dials in a few other optimizations.

In the Inspector, drag the background color Eyedropper and move it over the green

screen in viewer 2.

For convenience, Fusion draws an underlay pattern to indicate transparency. When
keying, however, this can make it difficult to see unwanted noise in the background.
We can turn the underlay effect off in the viewer menus.
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In the viewer menu, deselect Checker Underlay.

MediaOut1

When sampling an area of the frame for a key color, select an area where
the audience will be focusing its attention in the final shot. Doing so sets you
up for creating an optimal key.

Release the mouse button when the Eyedropper is near the guitarist's shoulder,
screen right.

As you select an area over the screen color, holding Command (macOS)
or Ctrl (Windows) allows you to drag out a rectangle to select an average
of an area.
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The green background mostly displays the checkboard. You've now created a matte for
the foreground shot by selecting a green color. Even if this matte looks satisfactory in
the viewers, you always need to check it for overall quality.

Above viewer 1, click the Color Controls button, or click the mouse button in viewer 1
to make it the active window and press the A key.

The matte for your live-action shot is displayed in viewer 1. A single click of the
Eyedropper typically produces a matte with lots of gray (semitransparency).

Drag the Gain slider slightly up to subtract more value from the green background.
Adjusting gain too far will cause some of the white foreground to become transparent,
so you only need to increase it a small amount. Staying under 1.3 should be safe.

Pulling a Green-Screen Key
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Drag the Balance slider to the right until it is between .3 and .4. The Balance slider
takes more or less information from the colors other than the screen color—in this
case, red or blue. Dragging it to the left causes blue to be more transparent, while
dragging it to the right causes red to be more transparent. Since there is a lot of red in
this foreground subject, dragging it to the left removes some of the transparency from
the foreground.

Although this is not nearly good enough for the final result, this is a good start, since it
retains all the fine hair detail.

Even with the cleanest of green-screen keys, such as you have here, you must refine the
matte a bit to ensure that areas intended to be opaque appear as solid white, and the
areas intended to be transparent appear as solid black.

Refining a Matte

Refining your matte is done within the Delta Keyer. Taken in stages, the first stage is to
ensure that you have selected all the various shades of green you can, without causing any
damage to the fine details in the matte. This pre-matte selection refinement is done in the
Pre-Matte tab of the Inspector.

In the Inspector, click the Pre-Matte tab.

Deltakeyer1

Final Result

(=]

Pre NRite

The goal in the Pre-Matte tab is to select areas of your green screen that were not
made transparent with the single-click Eyedropper. Selecting other areas will even out
the color selection of the green screen.

You can use the Clean Plate node in place of the Pre-Matte tab for more
control over the pre-matte process.
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In viewer 1, drag a selection rectangle around the dark gray area to the left of his hat.

When making these pre-matte selections, be careful not to get too close to the fine
hair details you're trying to preserve.

It may seem as if you have a pretty clean matte, but your computer screen can play
tricks with the gamma in your image. To offset the computer screen gamma setting,
you can make a temporary gamma adjustment to the viewer that will allow you to
check the matte for unwanted semitransparent areas.

From the Options menu in the upper-right corner of viewer 1, choose Gain/Gamma
from the list.
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Drag the Gamma slider up about halfway to view any gray areas in the transparent
background of the matte.

The gamma adjustment usually exposes some small areas that can be removed.

Drag a selection rectangle across any white specks that appear close to the guitarist.

During the pre-matte selection process, and during other matte refinements you'll
make later, do not concern yourself with parts of the screen that are not near our
foreground subject. Those areas are best handled by other mattes. But, conversely,
do not get too close to the fine hair details to prevent them from eroding.

The Pre-Matte keyer is designed to remove noise from the background but can
unintentionally damage the soft edge of the main matte (in this case, the silhouette
of the guitarist). To fix this, we can erode the pre-matte away from the main matte
to prevent it affecting the soft edge. We can then add a little softness to smooth the
transition between the pre-matte and the main matte.

Drag the Erode control up to around 0.002 to eat away at any holes created by the
soft range.

In the Inspector, drag the Soft Range slider up to around 0.02 to expand the pre-
matte selection.

Both the soft range and the erode are small adjustments that you may decide to come
back to later in the process if the edges around the subject become too pronounced.

To refine the matte density further, you can switch to the Matte tab of the Delta Keyer.

In the Inspector, click the Matte tab.

DeltakKeyer1

View Mode  Final Result

[&]

I".’Iatk Fringe
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The Matte tab contains parameters for modifying the density and edges of the matte.
It is arguably the most important tab in the Delta Keyer because the quality of your
matte determines the quality of your key. By adjusting the Threshold sliders at the top
of the matte tab, you clamp the black and white cut-off points. Values that fall below
the Low Threshold setting are considered as pure black (transparent), and values that
fall above the High Threshold setting are considered as pure white (opaque).

As you make adjustments to the matte, zoom in to, and/or expand the
viewer size to get a clearer look at the matte, especially around the fine
hair details.

To clamp the black, transparent areas of your matte, drag the Low Threshold slider

to the right until there are very few gray spots in the background. Again, pay extra
attention to the hair details. The more you increase the Low Threshold, the more you
eat away at the thin hair strands. In this shot, if you drag above 0.2 you have probably
lost some hair detail.

DeltaKeyer1

Final Result

(2]

Matte Fri

To clamp the white areas of the subject, drag the High Threshold slider to the left until
the white areas filling in the foreground are mostly pure white. Decreasing the High
Threshold too much below 0.75 can cause the fine details to merge together.

When refining the key, you are primarily concerned with getting good
quality edges for your subject. The black transparent areas and the core of your
foreground subject can be handled using various types of mattes.

The next steps are very subtle adjustments using the Clean Foreground and Clean
Background controls. You generally apply these with an extremely light touch because
they tend to cause harsh matte edges, but they can also “fill in” the small holes that
appear in the black and white parts of the matte. As you adjust them here, you'll use a
combination of the keyboard and the slider to make very small-scale adjustments.

Refining a Matte
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To fill in any black holes in the white areas of the matte, hold the Command key
(macOS) or the Ctrl key (Windows) and drag the Clean Foreground slider to around
0.0005, and then do the same for Clean Background.

From the Options menu, choose Gain/Gamma from the list to close the overlay and
reset the gamma in the viewer.

It will be impossible to refine the matte to the point where it fixes every pixel of the frame
without also sacrificing some of the hair detail. You'll find that for every shot, compositing
with green screen requires multiple tools that work together. However, the basic
adjustments in the Delta Keyer that you have completed here are a useful starting point
for any key.

Your matte still has unwanted areas such as the gray or semitransparent areas around
the lower portion of the guitar and a few white specks in the black transparent areas.
Sometimes, you won't be able to key out everything, so you need to pull out the digital
duct tape, more formally known as auxiliary mattes.

Auxiliary mattes are mattes other than the main core matte created by the key. These
auxiliary mattes help to patch matte holes that are impossible to patch otherwise. Two
auxiliary mattes are used regularly on every keying job. One is the garbage matte that
removes areas of the set not covered by the green screen. The second is a holdout matte.
The holdout matte covers up unwanted semitransparent areas in the foreground that the
keyer didn't catch. Let's start with creating a garbage matte.



From the toolbar, drag a B-Spline tool into the Node Editor under the Delta Keyer.

w

BSpline

Select the B-Spline node and rename it to GMATTE.

When drawing a matte, it is sometimes easier to use a B-Spline tool rather than Bézier
splines as you have been doing. B-Splines produce smoothed, curved edges without
the need to manage handles. For consistently smooth curved shapes (when you're not
concerned with making extremely detailed shapes with lots of corners), B-Splines can
be easier to work with.

Let's use the B-Spline tool to draw around the area you want to keep, and then invert
the matte.

When you draw a shape with a B-Spline curve tool, the control points you
set influence only the shape of the curve. The control points do not define the
location of the actual spline curve. That being the case, it is best to start by
drawing a very loose shape, and then adjust the control points to create the
curve you need.

In viewer 1, draw a wide, rough shape around the guitarist.
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Similar to drawing a polygon spline, remember to close the matte by
clicking on the first control point you added or by pressing Shift-O.

Once you finish drawing the matte, Option-drag (macQS) or Alt-drag (Windows) from
the GMATTE output to the Delta Keyer node.

Release the mouse button, and in the Input pop-up list, choose Garbage Matte.

v v
» GREENSCREEN m——p Deltakever [

You can adjust the smoothness of a B-Spline’s curve by holding down the
W key, selecting the control point for the curve, and dragging left or right to
increase or decrease the smoothness.

Because you drew this garbage matte around the subject, the guitarist's silhouette is
removed from the shot. You need to invert it.

Select the GMATTE node and, in the Inspector, click the Invert checkbox.

This matte is done only for a single frame, and this guitarist likes to move as he plays.
The drawing of polygon or B-Spline mattes and animating them over a series of frames
is called rotoscoping. A basic rotoscoping technique is called divide and conquer. Divide
and conquer bifurcates the clip with keyframes and continually divides each section
with keyframes until the motion of the object is covered. This ensures that you only
add keyframes when absolutely necessary.

Move to the end of the render range.

By default, after you close a polygon shape, any change you make to a control point
adds a keyframe. Changes to the shape on different frames are interpolated. This
behavior makes it incredibly efficient to animate small changes to your matte as the
subject in your clip moves.

Refine the shape to better fit around the guitarist by adjusting any of the control
points along the B-Spline.
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When animating a spline, you can move the entire shape by clicking the
Select All Points button in the viewer toolbar and then dragging the points to a
new area in the viewer. Moving the Center X and Y parameters or the onscreen
Center control will not add a keyframe.

When using the divide and conquer technique, the idea is to set keyframes at the
start, end, and middle of your animation. You then continue to divide those segments
by adjusting the shape to fit at halfway points between keyframes until the shape’s
movement in each segment accurately matches the object that you're trying to rotoscope.

Move to the middle of the render range, around frame 570.

Adjust the control points to fit around the guitarist.

Repeat the process by dividing the keyframed sections from frame 530 through frame
570 so that the animated shape fits the guitarist throughout the moving shot.

Above the viewer is a viewer toolbar, which is used to modify the spline shape.

When you come to a point where you must move the entire shape, click the Select All
Points button in the viewer toolbar and drag a control point to move all the control
points and set a keyframe.

Select All points (Shift+4)

Pressing Option-Left and Right Arrow (macOS) or Alt-Left and Right
Arrow (Windows) will move the playhead to the next and previous keyframe,
respectively, to help you more quickly refine the polygon matte.

Once you finish with the first half of the shot, divide the second half starting at frame
570 through frame 603. Adjust the shape wherever you feel a keyframe is needed,
continually dividing sections as you go.

Rotoscoping Auxiliary Mattes
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Another auxiliary matte you will typically create does the opposite of the garbage matte. A
holdout matte fills in any holes that appear in the white matte of the foreground subject.
Some bright areas of the white guitar have caught green bounce light from the screen. To

correct this area, you'll draw another polygon shape to cover the dark gray area where the
body of the guitar is located.

Move to frame 560 where you can clearly see the gray area in the matte.

From the toolbar, add a Polygon node into the Node Editor, next to the GMATTE node,
and rename it to HOLDOUT.



In viewer 1, zoom in to the matte and draw a shape around the midsection of the

matte to cover up any gray areas.

You should be able to create this matte with around 15 keyframes.

The holdout matte must be connected to a different input of the Matte control
than your garbage matte. A holdout matte is connected to the solid input on the
Delta Keyer.

Option-drag (macOS) or Alt-drag (Windows) from the HOLDOUT output to the Delta
Keyer node, and in the Input pop-up menu, choose Solid.

Using the divide and conquer technique again, adjust the polygon Bézier matte for
the remaining frames in this shot. Use the Select All Points button above the viewer or
draw a selection rectangle around a group of control points to move them, and then
refine any single points as needed.

An alternative to drawing a holdout matte is to create a very hard matte
using the Delta Keyer and then connect that into the Solid input.

A note about garbage mattes and holdout mattes: Often people unaccustomed to creating
green-screen composites attempt to do everything in the keyer. Let me dispel that myth
right now. Using auxiliary mattes is not an admission of a failed key. The use of auxiliary
mattes means that you are being smart about your time and are aware of the entire
process. Use a keyer for what it's good at: creating soft edges and extracting the fine hair
detail. Use the auxiliary mattes to avoid wasting time fiddling with keyer controls for items
easily done with a spline shape.
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Lining Up the Background

You can only go so far adjusting the matte against a black background. Eventually, you
must view the foreground over the actual background clip to get a complete picture of
the matte quality.

In the upper-left corner of the interface, click the Media Pool button, and from the
keying bin, drag the BKGD HD clip into an empty area of the Node Editor.

» MediaOutl |

> Medialni

Close the media pool to make more room for your viewers.

Press 2 to see the clip in the viewer.

The viewer is empty, as if there is nothing to see. Remember that the comp has start
and end times based on the source clip from the edit page timeline. If you view the
render range, it starts at frame 530. Unless the background clip you broughtinis
over 530 frames long, it will not be visible in this composition. It's helpful to view the
Keyframes Editor when bringing in new clips to see where they are located in time.

In the upper-right corner of the window, click the Keyframes button.

By default, the Keyframes Editor shows only tracks for animated controls. You'll need
to switch the filter menu to show all the tracks.

From the filter menu in the upper-right corner of the Keyframes Editor, choose
Animated to disable the filter.

F\nim?kt‘_d

The Keyframes Editor now shows all the tracks, including the background node. It is
clear now why the viewer is empty. The background node clip begins at frame 0 and
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ends at frame 73. This is a full 437 frames before the comp starts. You can use the
Global In/Out controls in the Inspector to slide the background clip into place.

Select the Medialn1 node in the Node Editor.

At the top of the Inspector, position the mouse pointer between the two Global In/
Out handles.

Medialn1

Cli BKGD_HD.mowv

Drag the Global In/Out bar to the right until you get near the 530 start frame.

When the Global In is near 530, zoom in to the Keyframes Editor and slide the clip into
place by dragging over it as you would in the edit page.

530  +|»BKGL_HDmov 603 |

Now you are able to view the clip in viewer 2.

With the Medialn1 node selected, press F2 and rename the clip BACKGROUND.
To view the key over the background, you'll use a Merge node.

In the upper-right corner of the window, click the Keyframes button to close the panel.

Click the connection line near the yellow input of the Media Out node to disconnect it.

> MediaOutl [ ]

Drag the output of the Delta Keyer to the output of the BACKGROUND node to create a
Merge node.

v v
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Drag the output of the Merge node to the Media Out node.

Select the Merge node and press 2 to display it in viewer 2 to see the initial composite.

Although this looks good for the amount of work we've done so far, the foreground and
background still look like very different images. The next step is to color correct both
elements so they appear as if they are in the same location.

Color Correcting Elements

Color correcting the background and foreground is done for two reasons. The first is to
remove any green color that remains on the foreground subject, and the second is to
match the foreground and background so they realistically appear to exist in the same
setting. Let's tackle the green tint issue first. The Replace Color at the bottom of the Matte
tab in the Inspector already includes a fair amount of spill suppression.

Select the Delta Keyer and, in the Inspector, select the Matte tab.

Spill is created from bounced light reflecting off the green screen that spills onto
the foreground subject. Since removing that green spill is inextricably linked to the
process of extracting a matte, you will sometimes create holes in your foreground
matte. This is due to the Replace Color attempting to remove the green-screen color
that has spilled onto your foreground. You inevitably must balance the quality of the
spill suppression with the generation of the matte. A way around this dilemmais to
set the Replace Color to Source.
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At the bottom of the Inspector, set the Replace Mode dropdown menu to Source.

@

Soft Color

Source

Green

Blue

Setting the Replace Color to Source reintroduces an amount of the original green-
screen pixels instead of trying to remove them. However, you are now left with green
spill on the musician.

You can remove spill fairly easily using a Color Corrector node directly after the
Delta Keyer.

From the toolbar, insert a Color Corrector node between the Delta Keyer and the
Mergel node.
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The Color Corrector node includes several modes for correcting highlights, midtones,
and shadows, as well as spill suppression.

At the top of the Color Corrector Inspector, choose Suppress from the menu.

Correction

Menu

Range

Zoom in to the viewer as far as needed to view the changes as you reduce
the spill colors.

The Suppress wheel allows you to drag the control point for the desired spill color
toward the center, thereby reducing its saturation.
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To reduce the green and some of the bright yellow tint around the edges of the
foreground, drag the green and yellow control points in toward the center of the
color wheel.

Correction

Menu  Suppress

Range  Master

In many cases, spill suppression can produce a noticeable reduction in
image brightness. You can counteract this effect by slightly raising luminance.

With the Color Corrector node selected, press Command-P (macOS) or Ctrl-P
(Windows) to disable the spill correction. Then, press that keyboard shortcut again to
re-enable the spill suppression.

Now you can focus on matching the foreground and background. You can choose to
perform the foreground color correction in the Fusion page by adding additional Color
Corrector nodes, or, since you have the world's best color grading tools on the color page,
you can perform the color correction there.

Sending a Matte to the Color Page

As you have experienced, the Delta keyer is an amazing tool for green-screen shots.

And although the Fusion page also includes extremely adept Color Correction nodes,
DaVinci Resolve offers world-renowned color grading tools on the color page. So, in some
cases you may want to use the two pages together for compositing a shot. In this exercise,
you'll use the matte from the Delta Keyer to color match the foreground and background in
the color page. It's a simple process to show you how easy it is to bring mattes from Fusion
into the color page.
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The main requirement in sending the matte from the Fusion page to the color page is
adding a Media Out node.

Click in an empty area in the Node Editor above the Delta Keyer node.

Clicking in an area of the Node Editor is a way of pinpointing where a node should be
placed when you add the next node.

Press Shift-Spacebar, type MediaOut, and then press Return/Enter to add the node to
the Node Editor.

Drag the output of the Delta Keyer to the input of the MediaOut2 node.

> MediaOut2
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The first Media Out node in the Node Editor always goes to the edit page. Additional
Media Out nodes go to the color page. You can add as many Media Outs as needed for
sending multiple mattes.

Most of the time that you use nodes in the color page, you are processing color data.
Occasionally, you may add an external matte from the media pool. In our case, we need to
add a source from the Fusion page.

Click the color page.

The green-screen clip you were working on in Fusion is now the currently selected clip
in the color page. You need to add a source that represents the MediaOut2 node (the
matte) from the Fusion page.
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In the Node Editor, right-click in an empty gray area and choose Add Source.

Add Source

XS

The source is added as a green icon on the left side of the Node Editor, directly under
the RGB source from the edit page. This second source is from the MediaOut2 in the
Fusion page. You can use it as either RGB data or an alpha channel since it includes
both. For this exercise, we'll use the second source as an alpha matte source.

Drag the output of the second source to the key input of node 1.

You now have a mask connected to node 1 so that any color correction you do will be
limited by the mask from the Fusion page.

Using the color page Gamma color wheel, lower the master wheel, push the color
toward yellow/green, and lower the overall saturation to better match the guitarist
with his background.
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The main point of this green-screen lesson is not only to teach you the steps in setting up
a green-screen key, but perhaps more importantly to show you that keying a foreground
subject is almost never completed using only one tool. It's far more common to employ
multiple techniques to address separate areas. In the end, if you learn to break down the
foreground into its own small problematic areas, you can address each area with different
tools to get the best possible results.

If you stopped here, you could be rather pleased with the results we've achieved in such a
small amount of time. However, you can also go the extra step and make it really special by
continuing on with Appendix A, which will introduce you to an additional color correction
step called a light wrap.

MediaOut2

GREENSCREEN — —————— Colot (alily > ———» MediaOut1

-]
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Completed node tree for Lesson 5.

Lesson Review

In the Fusion page, what is the primary tool for pulling a green-screen key?

True or false? A solid matte connects to the Delta Keyer in order to fill any holes
that appear in the white matte of the foreground subject.

True or false? Removing spill or bounce light coming from the screen onto the
foreground subject requires that you add a Color Corrector node.

True or false? Adjusting Threshold in the Delta Keyer suppresses spill on the foreground.

What project setting must be enabled for the Fusion page to automatically switch
all Media In nodes to linear gamma?

Lesson Review
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The Delta Keyer is the primary tool for green-screen keying.
True. A solid matte connects to the Delta Keyer to fill holes in the foreground subject.

False. Removing spill or bounce light coming from the screen onto the foreground
subject can be done in the Delta Keyer or additionally in a Color Corrector node.

False. Adjusting Threshold can clip only the black or white levels in a matte. It cannot
modify the RGB levels for spill suppression.

The Color Science setting must be set to DaVinci YRGB Color Managed to convert all
the Media In nodes to linear gamma in the Fusion page.
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Part |l

Titing and
Motion Graphics

One of the most interesting aspects of Fusion is that it can be used both for visual
effects work and for motion graphics. In this section, you'll learn how to animate
text and images using Fusion’s powerful keyframing, linking, and modifier system.
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Lesson 6

The Art of the

Credit Roll

Every scripted project, documentary,
or reality program ends with credits.

A lot of effort and thought goes into
deciding how those credits look and
the order in which the crew is listed.
Since there are no rules that guide
how credits are displayed, whoever is
finishing the project must be flexible
with the setup. One day all the text
may be justified to the left; the next
day it is centered.

Time

This lesson takes approximately
40 minutes to complete.

Goals

Starting with a Fusion Generator
Adding a Text+ Node

Aligning Text with Tabs
Formatting a Single Line
Inserting Logos and Graphics
Making Credits Roll

Converting to Pixel Values
Setting and Looping Keyframes

Lesson Review
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Although not principally designed for animating credit rolls, the flexibility inherent in
Fusion’s node-based interface turns out to be surprisingly good at producing credits.
Building a credit roll will reinforce some of the text functions you learned in Lesson 1,
while introducing you to some more advanced formatting and animation options.

DREAMLAND PRODUCTIONS
Executive Producer Robert Shaye
Directed By John Waters

Divine Francine Fishpaw
Tab Hunter Todd Tomorrow
Edith Massey Cuddles Kevinsky
Mink Stole Sandra Sullivan
David Samson Elmer Fishpaw
Joni Ruth White La Rue
Mary Garlington Lu-Lu Fishpaw

Completed composite for Lesson 6.

To start, you'll restore a new archive that will be used for the next three lessons that make
up Part II of this book.

Open DaVinci Resolve. In the Project Manager, right-click and choose Restore
Project Archive.

Navigate to the R18 Fusion Guide Lessons folder you downloaded and restore the
project.

When designing text, especially a credit roll, you don't necessarily need a video clip.
You just need a blank canvas on which to create. For those situations, you can add a
Fusion composition effect to your timeline and begin designing whatever you want.

The Timelines bin includes a Backups bin with timelines saved at various
stages of each lesson and a Completed bin with finished compositions. These
bins are available for both reference and reverse engineering the node trees.



In the edit page, load the timeline if it isn't already loaded.

Open the Effects Library, and then select the Effects category.

The Effects category includes two effects that act like containers for other effects.

Drag the Fusion Composition effect to the end of the timeline, making it the last clip.

AADT13_01.mov

Right-click over the Fusion Composition and choose Change Clip Duration. In the
dialog, enter 10000 to create a 1-minute clip, and then click Change.

When entering timecode in Resolve, there's no need to enter the colons
between the various time denominations. Resolve will automatically do
this for you.

Admittedly, this is on the shorter side of credit rolls, but rather than having you sit
through 5 minutes of credits, without the hope of seeing outtakes from the movie, this
will work for learning purposes.

Position the playhead over the Fusion Composition effect in the timeline and click the
Fusion button to go to the Fusion page.

A single Media Out node is the only node in the Node Editor. When using the Fusion
Composition effect, you have no Media In nodes. It is up to you to add whatever content
is required.

Starting with a Fusion Generator



Adding a Text+ Node

When you need to create text in the Fusion page, the primary tool is the Text+ tool. You
use it for any 2D title designs, from dynamic opening titles to simple credit rolls. You'll add
a Text+ tool to the Node Editor and then begin adding and formatting the text for your
credit roll.

Just before the first divider in the toolbar, drag the Text+ tool into the Node Editor and
connect it to the Media Out node.

No matter what you are creating or how you started the Fusion composition,
you always need to connect to the Media Out node to render back into the edit
page timeline.

» MediaOut1

You can also find the Text+ tool in the edit page Effects Library or the cut
page Title Library. Adding it to the edit page or cut page timeline provides the
same text formatting controls you'll find here, in the Inspector.

You'll need only one viewer for this lesson. To give yourself more room, you can use
either viewer 1 or viewer 2 in a single-viewer layout by clicking on the Single Viewer
button in the upper-right corner of either viewer.

In the upper-right corner of viewer 1, click the Single Viewer button.

Select the text node in the Node Editor and press 1 to see it in the viewer.
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In the Inspector’s Styled Text field, enter DREAMLAND PRODUCTIONS, and then press
Return/Enter to create a line break.

Set the Font to Open Sans and set the font typeface to Regular.

Open Sans

Bold

Regular

Change the text size to around 0.05.

DREAMLAND PRODUCTIONS

The text size is not based on font point size but is measured relative to the
width of the frame. Therefore, changing the resolution maintains the relative
size of the text in the frame.

You can enter multiple lines of text and format them how you want. However, the easiest
method for a credit roll is to write them in a word processor and then copy and paste them
into the Text+ tool.
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Aligning Text with Tabs

Credits can be hundreds of names long. Grouping your credits into categories is the only
way to keep things organized. You can have all the information, but unless you carefully
organize it, you won't be able to correct names or reorder the credits easily. To start, write
your credits in a simple text app or word processor. You can then check spelling and easily
share it with other people in the crew who might not be involved in post-production. Once
you have the text document, simply copy and paste it into the Text+ tool.

On your computer’s hard drive, navigate to the R18 Fusion Guide Lessons folder >
Fusion files and open the document in a text app or Notepad.

Select and copy the first two lines for the executive producer and the director.

& ® CREDITS

Executive Producer Robert Shaye
Directed By John Waters I

Cast
Divine Francine Fishpaw
Tab Hunter Todd Tomorrow
Edith Maceau Cuddlee Weauinelbw

Once you've copied the first two names, you can return to the Fusion page and paste
them into the Text+ tool.

In the Inspector, click below DREAMLAND PRODUCTIONS to insert the cursor in the
field, and then press Command-V (macOS) or Ctrl-V(Windows).

Styled Text | DREAMLAMD PRODUCTIONS
Executive Producer Robert Shaye
Directed By John Waters

The text is pasted into the Styled Text field and is seen in the viewer. All words in the
Text+ tool start center justified; however, that can be changed using tabs. You'll leave
DREAMLAND PRODUCTIONS center justified but add tabs to align the executive
producer and director’s credits.
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In the text field, before the E in Executive Producer, insert the text cursor and press Tab.

Styled Text |DREAMLAND PRODUCTIONS
Executive Producer Robert Sha
Directed By John Waters

Insert the text cursor before the R in Robert and press Tab again.

Do the same before the D in Director and the ] in John, inserting a tab for each.

DREAMLAND PRODUCTIONS
Executive Producer Robert Shaye
Directed By John Waters

The text in the viewer appears a bit worse in terms of layout, but that is only because
you have not positioned the tabs.

At the bottom of the Inspector, click the disclosure arrow to reveal the tab
spacing controls.

v Tab Spacing

ition

Alignment

When you add tabs to the text, the tab spacing controls allow you to position the tabs
in the frame and determine how the text aligns with those tabs. The number menu at
the top of the Tab Spacing controls indicates which tab you are currently adjusting.

Drag the position slider to -0.1, or to be more precise, enter -0.1 in the numeric field.

The tabs use a value of 0.0 as the center of the frame; -0.5 is the left edge, and 0.5 is
the right edge. So, tab 1 is now set slightly off to the left of the center. However, the

text is still center aligned on that tab. Using the Alignment slider, you can choose to

align the text left, center, right, or any offset in between.

Clicking the tab handle above the viewer cycles through left, right, and
center alignment.

Drag the Alignment slider all the way to the right, right justifying the text on the tab.

Aligning Text with Tabs
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This causes the ending of the words Executive Producer and Directed By to be right-
aligned to the tab.

DREAMLAND PRODUCTIONS
Executive Producer Robert Shaye

Directed By John Waters

Now for tab 2, you'll do the same setup in the opposite direction.

In the Tab Spacing controls, change the Tab pop-up to 2 to control the position and
alignment properties for tab 2.

Drag the Position slider or type in 0.1 to move tab 2 off to the right.

Drag the Alignment slider all the way to the left, left justifying the text on the tab. This
causes the start of both men’s names to be aligned to the tab.

DREAMLAND PRODUCTIONS
Executive Producer Robert Shaye

Directed By Jahn Waters

The Art of the Credit Roll



You now have the basic setup for your credit roll. Any text that you type or copy and
paste into the Styled Text field is now center aligned in the frame unless they have
tabs. If the text you type or paste includes tabs, the formatting is based on the tabs

in the Text+ tool.

Return to the CREDITS document, select the text starting from the word CAST and
including up to the last actor. Press Command-C (macOS) or Ctrl-C (Windows) to

copy the text.

Executive Producer Robert Shaye

Directed By John Waters

Cast
Divine Francine Fishpaw
Tab Hunter Todd Tomorrow
Edith Massey Cuddles Kevinsky
Mink Stole Sandra Sullivan
David Samson Elmer Fishpaw
Joni Ruth White La Rue
Mary Garlington Lu-Lu Fishpaw
Ken King Dexter Fishpaw
Hans Kramm Heintz
Stiv Bators Bo-Bo Belsinger
Rick Breitenfeld Dr Quackenshaw
Michael R Watson Freddy Ashton
Derek Neal Pimp
Jean Hill Gospel Bus Hipster
Jim Hill Picket Reporter
John Brothers Tv News Announcer
Mary Vivian Pearce Nun A

Sharon Niesp Nun B
Cookie Mueller Betty Lﬁl&ﬂﬁ#}

Susan Lowe Mall Victim
Tony Parkham Teenage Witness
Paul Holland Pizza Man Lover

Alberto Panella 2nd Pizza Man
Frank Tamburo 3rd Pizza Man
Nancy Morgan Alcoholic Leader

Keats Smith Boutique Saleslady
Gordon Kamka Detective A
David Klein Detective B

George Stover Press A
Steve Yeager Press B I

Back in the Fusion page Inspector, click below DIRECTED BY to insert the cursor in
the Styled Text field, and then press Command-V (macOS) or Ctrl-V (Windows) to

paste the text.

Aligning Text with Tabs
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Before pasting the text, you may need to press Enter/Return to create a
line break after the director’s name if you haven't done so already.

v Text

DREAMLAND PRODUCTIONS
ive Producer  Robert Shaye
Directed By John Waters

Cast
Divine  Francine Fis
Tab Hunter Todd T
Edith Massey Cuddles Kevinsky
Mink Stole  Sandra Sullivan

Since the text document already includes tabs, the pasted text aligns to the tabs in the
Text+ tool. The text layout in the viewer expands to include the new text, causing some of
the text to fall outside the active frame area. Text that falls outside the active frame area
can be seen as outlines, making it easy to read and format all the text in the credit roll.

Formatting a Single Line

If you change the font, size, or color of the text in the Text+ node, it changes the entire text
block that you have entered. To change the style of a single letter, word, or line, you must
use a special modifier called Character Level Styling.

Right-click in the Styled Text field and choose Character Level Styling from the menu.

v Text

DREAMLAND PRODUCTIONS
Executive Producer  Robert Shaye
Directed By |ohn Waters
Cast
Divine Fra
Tab Hunter
Edith Masse'
Mink Stole

Character Level Styling

3

Modifiers provide add-on functionality to the core capabilities of a tool. They are
applied by right-clicking on the parameter you want to modify and choosing the
appropriate modifier. The Character Level Styling modifier allows you to override the
Text+ tool's global styling. Now, you can select the letters in the viewer that you want
to style differently.
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With the mouse pointer over the viewer, hold the Command key (macOS) or the Ctrl
key (Windows) and scroll the middle mouse wheel until you are able to see the outlines
of the DREAMLAND PRODUCTIONS text above the frame.

Mary Garlington Lu-Lu Fishpaw
Ken King Dexter Fishpaw
Hans Kramm Heintz

Stiv Bators Bo-Bo Belsinger
Rick Breitenfeld Dr Quackenshaw
Michael R Watson Freddy Ashton
Derek | Pimp
Jean Hill Gospel Bus Hipster
Jim Hill Picket Reporter
John Brothers Tv News Announcer
Mary Vivian Pearce Nun A
Sharon Niesp Nun B
Cookie Mueller Betty Lelinski
Susan Lowe Mall Victim

You'll style the DREAMLAND PRODUCTIONS heading using bold typeface.

Drag a selection rectangle around DREAMLAND PRODUCTIONS to select it, being
careful not to select other letters.

In the Inspector, click the Modifiers tab.

Inspector
Tools

CharacterLevelStyling1

T

When using a modifier, all adjustments for the modifier must be done in the Modifier
tab of the Inspector.
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Set the font typeface menu to Bold and set the Size to 0.06.

You can still return to the main tools tab in the Inspector to change the main body of the
text. Text that has character level styling only updates if you select the text in the viewer
and use the Modifiers tab.

Inserting Logos and Graphics

Very often, credits are not limited to text, and you come across logos that you must add
into the credit roll. Using a Transform node and a Merge, you can insert your logo or
additional pages of text anywhere in the credit roll.

In the upper-left corner of the window, click the Media Pool button.

Select the Credit Roll bin and drag the DREAMLAND LOGO tiff into an empty area of
the Node Editor.

> Medialn1

» MediaOut1 [ ]

Select the Text1 node in the Node Editor and click the Merge tool in the toolbar
to add it.

Connect the output of the Medialn1 node to the output of Text1 to create a
Merge node.

Medialnl

Mergel —_— MediaOut1

A
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Select the Merge node and press 1 to see it in the viewer.

Like all images you add to the Node Editor, its location is in the center of the frame.
Media In nodes have no inherent positioning controls built into them. If you want to
move or scale a Media In node’s image, you must use a Transform node.

Select the Medialn1 node and, from the toolbar, click the Transform tool to insert it
between the Medialn1 node and the Merge node.

Medialn1

»

Mergel

In the Inspector, drag the Size slider down to about 0.5.

Assuming you want this logo to appear at the end of the credits, to position it
accurately you'll need to see the logo in context with the cast text.

In the Node Editor, drag a selection rectangle around the Text1 node, the Merge node,
and the Medialn1 node and its Transform node.

Medialn1

> MediaOutl |

Now you can see the cast text and the logo in the viewer. Instead of scrolling the
viewer back to see the last name of the cast text, you can get away with just panning
the viewer up.

Inserting Logos and Graphics
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In the viewer, press the middle mouse wheel and drag up until you are able to see the
bottom of the cast text, and a bit below where you will want the logo to be positioned.

201dIUTT INIESD INUlLlL D
Cookie Mueller Betty Lelinski
Susan Lowe Mall Victim

In the Inspector, use the Transform1 Center Y controls to position the logo below the
cast text.
201dIUTT INTES P iNUll D

Cookie Mueller Betty Lelinski
Susan Lowe Mall Victim

You can continue adding new pages and logos to create longer credits, using additional
Text+ nodes for each department in the crew. Once you have everything in place, you can
create the actual movement for the roll.
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Making Credits Roll

Animating in Fusion is not very different from animating in the edit page. Although the
Fusion page provides in-depth tools for refining animation, to get something moving you
can just use the Inspector.

Position the playhead at the start of the render range by dragging the red playhead or
by clicking the First Frame button in the transport controls.

The easiest way to move the text and the logo is to add a Transform tool directly after
the Merge node. This causes both the text and the logo to be controlled by the new
Transform node simultaneously. Changing the Transform parameters causes any items
connected to its input to follow.

Select the Merge node and then, from the toolbar, click the Transform tool to insert it
between the Merge node and the Media Out node.

(= Medialn1

|
v
> Transform1

hd
Transform2

Press 1 to see the Transform1 tool in the viewer.

To fill the viewer with the entire frame, choose Fit from the magnification dropdown
menu in the upper-left corner of the viewer or click anywhere in the viewer and press
Command-F (macOS) or Ctrl-F (Windows).

Making Credits Roll
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Make sure the playhead is at frame O (the start of the timeline). In the Inspector, click
the Keyframe button to the right of the Center X and Y controls.

Transform2

3
o

Controls

Vv Transform
Center X 0.5

Pivat X 0.5

Just like the edit page, you have now enabled keyframing for the Center Xand Y
position controls. You have also set a keyframe at the current playhead position.

In the Inspector, position the mouse pointer over the Center Y numeric field and drag
to the left to lower the text in the frame. Keep dragging until the first line of the credit
roll is out of the frame (around -1.2 or -1.3).

The easy method of finishing a credit roll is to move the playhead to the end, set a new
keyframe, and scroll the text off the top of the frame. However, pesky motion artifacts
typically result from using that technique. Whether you call it jitter, flicker, stutter, or
strobing, fixing motion artifacts with credit rolls can seem hit or miss. Luckily, however, it is
reasonably straightforward to correct this in Fusion.

Converting to Pixel Values

The only real way to achieve flicker-free rolling credits is to create a roll that moves two or
three pixels per frame. It is essential that the roll does not move at a sub-pixel rate; it must
use integer (whole number) values. This restriction is not dependent on which software
you use. Wherever you create your rolling credits, to avoid flickering